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may only be used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

This document is protected under copyright law. An authorized licensee of Avid Media ComposerNewsCutterAvid Symphony 
Nitris may reproduce this publication for the licensee’s own use in learning how to use the software. This document may not be 
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document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. does not accept 
responsibility of any kind for customers’ losses due to the use of this document. Product specifications are subject to change 
without notice.

Copyright © 2013 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Apple Computer, Inc.:
APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING 
THIS PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY 
PARTICULAR PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE 
ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. 
THERE MAY BE OTHER RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose 
is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of 
the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any 
advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon 
Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR 
OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT 
OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, 
DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF 
LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved. 

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph 
are duplicated in all such forms and that any documentation, advertising materials, and other materials related to such 
distribution and use acknowledge that the software was developed by the University of California, Berkeley. The name of the 
University may not be used to endorse or promote products derived from this software without specific prior written 
permission. THIS SOFTWARE IS PROVIDED ``AS IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. 

Copyright (C) 1989, 1991 by Jef Poskanzer. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission 
notice appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

http://www.avid.com/US/about-avid/legal-notices/patent-marking
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granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission 
notice appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1996 Daniel Dardailler. 

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that 
the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in 
supporting documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to 
distribution of the software without specific, written prior permission. Daniel Dardailler makes no representations about the 
suitability of this software for any purpose. It is provided "as is" without express or implied warranty. 

Modifications Copyright 1999 Matt Koss, under the same license as above. 

Copyright (c) 1991 by AT&T. 

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this 
entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all 
copies of the supporting documentation for such software. 

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, 
NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE 
MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Nexidia Inc.:
© 2010 Nexidia Inc.  All rights reserved, worldwide.  Nexidia and the Nexidia logo are trademarks of Nexidia Inc. All other 
trademarks are the property of their respective owners.  All Nexidia materials regardless of form, including without limitation, 
software applications, documentation and any other information relating to Nexidia Inc., and its products and services are the 
exclusive property of Nexidia Inc. or its licensors.  The Nexidia products and services described in these materials may be 
covered by Nexidia's United States patents: 7,231,351; 7,263,484; 7,313,521; 7,324,939; 7,406,415, 7,475,065; 7,487,086 
and/or other patents pending and may be manufactured under license from the Georgia Tech Research Corporation USA. 

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code 
equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be 
liable for any damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or 
operation of reseller’s products or the software; or any other damages, including but not limited to, incidental, direct, indirect, 
special or consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller’s 
products or the software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates 
has been advised, knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with 
respect to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by 
Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use 
of this software will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players 
and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample 
Source Code:
©1993–1998 Altura Software, Inc.

The following disclaimer is required by Ultimatte Corporation:
Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are 
subject to copyright protection.
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The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

The following disclaimer is required by Interplay Entertainment Corp.:
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid 
products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third 
Party Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in 
connection with Avid Interplay.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf 
of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms 
of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
003, 192 Digital I/O, 192 I/O, 96 I/O, 96i I/O, Adrenaline, AirSpeed, ALEX, Alienbrain, AME, AniMatte, Archive, Archive II, 
Assistant Station, AudioPages, AudioStation, AutoLoop, AutoSync, Avid, Avid Active, Avid Advanced Response, Avid DNA, 
Avid DNxcel, Avid DNxHD, Avid DS Assist Station, Avid Ignite, Avid Liquid, Avid Media Engine, Avid Media Processor, Avid 
MEDIArray, Avid Mojo, Avid Remote Response, Avid Unity, Avid Unity ISIS, Avid VideoRAID, AvidRAID, AvidShare, AVIDstripe, 
AVX, Beat Detective, Beauty Without The Bandwidth, Beyond Reality, BF Essentials, Bomb Factory, Bruno, C|24, 
CaptureManager, ChromaCurve, ChromaWheel, Cineractive Engine, Cineractive Player, Cineractive Viewer, Color Conductor, 
Command|24, Command|8, Control|24, Cosmonaut Voice, CountDown, d2, d3, DAE, D-Command, D-Control, Deko, 
DekoCast, D-Fi, D-fx, Digi 002, Digi 003, DigiBase, Digidesign, Digidesign Audio Engine, Digidesign Development Partners, 
Digidesign Intelligent Noise Reduction, Digidesign TDM Bus, DigiLink, DigiMeter, DigiPanner, DigiProNet, DigiRack, 
DigiSerial, DigiSnake, DigiSystem, Digital Choreography, Digital Nonlinear Accelerator, DigiTest, DigiTranslator, DigiWear, 
DINR, DNxchange, Do More, DPP-1, D-Show, DSP Manager, DS-StorageCalc, DV Toolkit, DVD Complete, D-Verb, Eleven, 
EM, Euphonix, EUCON, EveryPhase, Expander, ExpertRender, Fader Pack, Fairchild, FastBreak, Fast Track, Film Cutter, 
FilmScribe, Flexevent, FluidMotion, Frame Chase, FXDeko, HD Core, HD Process, HDpack, Home-to-Hollywood, HYBRID, 
HyperSPACE, HyperSPACE HDCAM, iKnowledge, Image Independence, Impact, Improv, iNEWS, iNEWS Assign, iNEWS 
ControlAir, InGame, Instantwrite, Instinct, Intelligent Content Management, Intelligent Digital Actor Technology, IntelliRender, 
Intelli-Sat, Intelli-sat Broadcasting Recording Manager, InterFX, Interplay, inTONE, Intraframe, iS Expander, iS9, iS18, iS23, 
iS36, ISIS, IsoSync, LaunchPad, LeaderPlus, LFX, Lightning, Link & Sync, ListSync, LKT-200, Lo-Fi, MachineControl, Magic 
Mask, Make Anything Hollywood, make manage move | media, Marquee, MassivePack, Massive Pack Pro, Maxim, Mbox, 
Media Composer, MediaFlow, MediaLog, MediaMix, Media Reader, Media Recorder, MEDIArray, MediaServer, MediaShare, 
MetaFuze, MetaSync, MIDI I/O, Mix Rack, Moviestar, MultiShell, NaturalMatch, NewsCutter, NewsView, NewsVision, Nitris, 
NL3D, NLP,  NSDOS, NSWIN,  OMF, OMF Interchange, OMM, OnDVD, Open Media Framework, Open Media Management,  
Painterly Effects, Palladium, Personal Q, PET, Podcast Factory, PowerSwap, PRE, ProControl, ProEncode, Profiler, Pro Tools, 
Pro Tools|HD, Pro Tools LE, Pro Tools M-Powered, Pro Transfer, QuickPunch, QuietDrive, Realtime Motion Synthesis, Recti-Fi, 
Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, Reprise, Res Rocket Surfer, Reso, RetroLoop, Reverb One, 
ReVibe, Revolution, rS9, rS18, RTAS, Salesview, Sci-Fi, Scorch, ScriptSync, SecureProductionEnvironment, Serv|GT, 
Serv|LT,  Shape-to-Shape, ShuttleCase, Sibelius, SimulPlay, SimulRecord, Slightly Rude Compressor, Smack!, Soft 
SampleCell, Soft-Clip Limiter, SoundReplacer, SPACE, SPACEShift, SpectraGraph, SpectraMatte, SteadyGlide, 
Streamfactory, Streamgenie, StreamRAID, SubCap, Sundance, Sundance Digital, SurroundScope, Symphony, SYNC HD, 
SYNC I/O, Synchronic, SynchroScope,  Syntax, TDM FlexCable, TechFlix, Tel-Ray, Thunder, TimeLiner, Titansync, Titan, TL 
Aggro, TL AutoPan, TL Drum Rehab, TL Everyphase, TL Fauxlder, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL 
Utilities, tools for storytellers, Transit, TransJammer, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Video the Web Way, 
VideoRAID, VideoSPACE, VTEM, Work-N-Play, Xdeck, X-Form, Xmon and XPAND! are either registered trademarks or 
trademarks of Avid Technology, Inc. in the United States and/or other countries.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States 
and/or other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other 
countries. Windows is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other 
countries. All other trademarks contained herein are the property of their respective owners. 

http://www.apache.org/
http://jcifs.samba.org/
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Footage
Arri — Courtesy of Arri/Fauer — John Fauer, Inc.
Bell South “Anticipation” — Courtesy of Two Headed Monster — Tucker/Wayne Atlanta/GMS.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Eco Challenge British Columbia — Courtesy of Eco Challenge Lifestyles, Inc., All Rights Reserved. 
Eco Challenge Morocco — Courtesy of Discovery Communications, Inc.
It’s Shuttletime — Courtesy of BCP & Canadian Airlines. 
Nestlé Coffee Crisp — Courtesy of MacLaren McCann Canada. 
Saturn “Calvin Egg” — Courtesy of Cossette Communications. 
“Tigers: Tracking a Legend” — Courtesy of www.wildlifeworlds.com, Carol Amore, Executive Producer.
"The Big Swell" — Courtesy of Swell Pictures, Inc.
Windhorse — Courtesy of Paul Wagner Productions.

Arizona Images — KNTV Production — Courtesy of Granite Broadcasting, Inc., 
Editor/Producer Bryan Foote.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Ice Island — Courtesy of Kurtis Productions, Ltd.
Tornados + Belle Isle footage — Courtesy of KWTV News 9.
WCAU Fire Story — Courtesy of NBC-10, Philadelphia, PA.
Women in Sports – Paragliding — Courtesy of Legendary Entertainment, Inc.
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1 Digital Cinema and TV Productions

Production companies, post houses, and audio post facilities need to stay connected and in 
constant contact to meet tight deadlines and stringent quality requirements. Offline editing, 
sound post, effects and graphics work can take place at different facilities, and Avid editing tools 
and interconnectivity solutions support the file interchange workflows between these specialized 
post facilities. 

Modern advances in cinematography, like the digital cameras from RED, Arri, and Sony, have 
changed the media-creation industry. The new generation of video cameras records to digital 
media instead of film or videotape. This allows editors to copy the file-based media directly onto 
the editing system. As a result, productions can now be edited from start to end using a tapeless 
format.

File-based workflows can greatly accelerate post-production, replacing real-time tape capture 
with much faster file-based import along with the integral metadata to preserve image quality 
throughout the editing pipeline. With the emergence of new digital cameras that can record 
images with higher precision and dynamic range, media can come in varying size, resolution, 
aspect ratio, frame rate, compression, and color encoding (color model, bit depth, gamma). Avid 
applications have adapted to allow better handling of resolutions and color encoding that these 
cameras and formats are constantly introducing.

You now have a reliable approach to achieve accurate and consistent color throughout your 
workflow. The editing application will ease the editing of high-resolution images and properly 
manage the colors in these images right through the production pipeline. The metadata 
associated with the files ensures that the original information is represented as accurately as 
possible, and enables other downstream systems and processes to reproduce the same look for 
final delivery to cinema, HD, SD or web formats. The source file metadata is transferred via 
Avid’s AAF to exchange color and spatial information with partner products, and ensure that the 
media can be re-linked within the Avid and partner eco-systems.

Media Composer’s first step towards resolution independence allows you to link directly to the 
high-resolution footage (2K and higher), and apply the necessary color transformations and 
image framing options, all within an HD/SD project. For example, you can perform your 
editorial within an HD frame size, and still pan over the high resolution image to keep the 
important action within view.
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While performing the edit, you can perform a background transcode of the media used in your 
sequence so that you can continue the editorial in a lower resolution, but with improved 
playback. For the finishing, you can then relink back to the high-resolution footage for the final 
render and output to HD, SD or other delivery formats.

The scenarios presented in this document provide recommendations for file-based workflows 
using Avid products. 

• Digital Cinema (2K+ documentary or movie productions) and Scripted TV (series, soap 
operas, commercials)—see “Workflow: Digital Cinema Production” on page 14.

• Unscripted TV (reality, talk, or lifestyle TV shows)—see “Workflow: Unscripted TV 
Production” on page 19.

Considerations when Editing with File-Based Media

Your Avid editing system can work directly with footage that is already in digital file format, 
such as files from digital video cameras or film scanning processes. Avid Media Access (AMA) 
is a plug-in architecture that allows you to link to clips and preview footage directly from a 
storage device without necessarily importing the media into your storage.

To link to a particular file-based format, you need the appropriate AMA plug-in installed on your 
system. There are a number of AMA plug-ins that can be downloaded from the Avid.com/AMA 
web page or participating third-party web sites. Install the plug-ins designed for the types of 
media that you will be editing. 

You may begin editing with the linked source material immediately. If the media management 
needs of the project are not great, the project does not require several streams of video to play 
concurrently (as with multicam sources), and the CPU and storage is up to the task, then the 
offline process can continue using linked media. 

System performance when editing with linked media also depends on whether the Avid editing 
system supports the media format natively or non-natively. NATIVE codec support means you 
can work with the camera media without the need to transcode first. NON-NATIVE codec 
support means that the media must first be imported or transcoded before the Avid system can 
manage it. With AMA, you can still link to footage that is non-native and get direct access to it, 
however, depending on the format of the source, there may be performance delays when playing 
the clips.

Media formats that have native codecs can be consolidated. Consolidating simply rewraps your 
files as Avid MXF OPAtom media, and places them into the Avid MediaFiles folder for 
indexing. Consolidating preserves the camera's original codec e.g. XDCAM stays XDCAM; 
DVCPRO HD remains DVCPRO-HD. The respective storage rates of the data, however, are not 
reduced when media is consolidated given the same original span of the media.
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When working with non-native file formats, and should you need better playback performance 
during the editorial, you can transcode the original files to low-resolution proxies. Transcoding 
takes the original essence and converts it to either Avid HD or SD media in a different codec with 
a data rate of choice. If you are transcoding to SD, then you can expect much less storage 
requirements for the offline. If you transcode to HD, depending on the resolution you go with, 
you may get little or no storage reduction benefit.

Before the editorial begins, you can transcode all the camera files to low-res proxies on a 
high-bandwidth primary storage to save space and work with better playback performance for 
the editorial. For the finishing, you may then transcode just the required media to a higher, 
output-quality resolution on the primary storage. Finally, if your project needs to be delivered in 
a higher-than-HD format, you can consolidate and move the original camera essence to a 
primary storage where they can be accessed by the finishing applications.

In an Avid Interplay environment, the relink process is dynamically managed. The system tracks 
the different media qualities and spans, then automatically links to the resolution that you 
request. On standalone editing systems, however, you should consider how you organize your 
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source and transcoded footage. For example, you may want to organize your clips into separate 
“source” and “proxy” bins to allow you to switch to the appropriate bin that holds the clips with 
the resolution that you require.

Here is a suggested order in which you can prepare, edit and conform your file-based media:

• Move the media from the camera drives to a more robust, high-capacity drive and organize 
the files into a proper folder structure that works best for your facility's workflows.

• After the files are organized, connect the drives to your Media Composer system and 
AMA-link to the appropriate folders to create the necessary bins containing the linked 
master clips.

• Any preparation of media for the editorial process should take place on the AMA-linked 
master clips so that they will available for the conform stage as well. These adjustments 
typically include general color space adjustments that need to be applied to all files from the 
same camera.

• Transcode all your footage to a low-res format SD or DNxHD 36 resolution optimized for 
the offline workflow.

• Build a rough-cut of your sequence by previewing and cutting with the proxy clips.

Once you start editing with the proxies, any color or spatial adjustments should be applied to 
the proxy clips in the bin. You then need to refresh the sequence in order to propagate the 
adjustments to the sequence. 

• Relink your sequence to the AMA clips.

• Transcode the sequence to a higher-resolution for the finishing and output.

For step-by-step details on the complete workflow, see “Checklist: File-Based Editing Workflow 
on a Standalone Editing System” on page 26.

Organizing your File-Based Media

Avid recommends moving all your camera footage to a robust storage, and organizing the source 
files in a manner that will ease the search for specific footage. You can structure the root folders 
as you see fit (e.g. Day 1, Day 2) but it is important that the actual card structures from the 
camera remain as they were shot. Typically, these folders contain metadata files that need to 
remain with the camera media. 
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When organizing your files, keep the following in mind:

• You will not be able to AMA link to a volume or file if the file path name has an illegal 
character. AMA clips display offline if the file path name you are linking to contains illegal 
characters, including < > : “ / | ? *. for Windows and : for Macintosh.

• During the AMA-linking process, you can select a subfolder containing the media files. 
AMA can find and link to these files as long as they are not more than 2 folder levels down 
from the selected folder.

• Windows UNC (Universal Naming Convention) paths are supported with AMA media. You 
can move your AMA bins from a Windows system to a Macintosh system and from a 
Macintosh system to a Windows system. The media files need to reside in the same shared 
location when you move the bins to and from different operating systems.

After all media has been moved to the storage, create an archive of the organized drive for 
backup.

When linking to the footage, you can configure the system to automatically organize the master 
clips into one or more bins. When the bins are created, create any necessary columns so that you 
can add information that will properly identify your clips for the downstream conform process.

During the editorial process:

• Do not rename or reorganize the folders with the original media once the editorial has begun.

• Do not delete the clips or bins created by the AMA process. You can close them and reopen 
them later when you need to relink to the original media.
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Workflow: Digital Cinema Production

Digital cameras can record footage at high-quality resolutions of 2K and up. This makes for 
bright and realistic images that are ideal for digital cinema productions. During the 
post-production process, this quality may only be required during the final finishing stages, so 
it’s best to use a lower resolution for the offline editing and economize on time and disk space. 
Depending on your delivery requirements, you can finish by switching to a higher target 
resolution, or conforming the project on another editing system where you can view the material 
at higher-than-HD resolution.

The illustration below shows a typical workflow for feature film editing using both Avid and 
3rd-party applications.
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For detailed procedures, see:

• “Checklist: File-Based Editing Workflow on a Standalone Editing System” on page 26

Dailies Creation

There are many companies that provide tools and technologies to streamline the preparation of 
dailies. The dailies process involves the fixing of timing errors, duration problems, audio/video 
synchronization, framing, color grading or spatial alignment. Also, when a film is shot in 3D, 
there are additional fixes required to adjust color and spatial alignments between the left/right 
eye images. 

The dailies systems also inject the necessary metadata to facilitate other downstream editing 
processes. Not all these functions need to be completed in the dailies as they can be undertaken 
in the video editing application. Your workflow, timescale, storage capacity and other criteria 
will determine the best flexibility in the pipeline.

Once the footage to be delivered to editorial has been identified, it is typically passed on in the 
form of transcoded MXF or QuickTime files. The processed media is then sent to the creative 
editorial suite along with the associated sequence AAFs, ALEs, and LUTs from the color 
grading process. 

If you have adequate disk storage, you can edit in Media Composer at full resolution to maintain 
the best possible quality. It is also possible to acquire lower resolution HD proxy footage for the 
selected takes, and at a later time pass a pull list back to dailies to obtain the full resolution 
equivalents.

•

Acquisition of High-Resolution Media

With a file-based workflow, the footage is already in digital file format so the editing system can 
link to media directly on a camera or storage device. Avid systems support media originating 
from a variety of cameras and formats which have different codecs, color encodings, frame rates 
and raster sizes. All metadata is taken into account during acquisition and preserved along with 
the project and media information.

Since file sizes tend to be large, the real-time playback of media on the timeline may be 
compromised. As such, it may be advantageous to transcode the footage to a lower-res format for 
the rough cut, and then link back to the original media before applying the final effects and 
outputting the sequence. Some cameras can even record in MXF formats that can be handled in 
Media Composer without the need to transcode.
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The majority of high-resolution (2K+) file-based media comes from devices that have their own 
set of Look Up Tables (LUT) for advanced color management. These LUTs may come from the 
digital camera on which the footage was recorded, or from color grading done during the dailies 
processing. These LUTs need to be incorporated with the incoming media so that Media 
Composer can seamlessly apply the necessary color transformations at the appropriate stages 
during the editorial process. (Media that is pre-processed by other applications in the dailies or 
other upstream processes can be linked in Media Composer via AAFs or ALEs.)

Acquisition to Shared Storage

With an Avid shared storage solution, you can quickly increase collaboration in a post facility. 
There are Avid storage solutions for facilities with standalone editing systems, as well as larger 
networked systems requiring high-resolution storage and bandwidth.

In post productions with high shoot ratios, such as reality TV, an hour of programming can 
involve perhaps 100 hours of raw media to process. This requires media to be copied from 
camera storage to an Avid ISIS shared storage. However, this means that a lot of capacity is 
required to hold media that might be discarded later in the process. To make the process more 
efficient, a low-bandwidth ISIS 2000 can be used as a “parking storage” for the source media. 
After the editor has previewed the media and created clips of the usable shots, the required media 
can then be moved from the source files to the high-bandwidth ISIS 5000/7000 storage. Media 
can also be consolidated or transcoded to give editors better performance during playback of 
sequences. 

Linking to File-Based Media

When working with media coming directly from digital cameras or other media-creation 
applications, many editors use AMA to link to and edit their footage. Editing stations connected 
to a digital camera or card reader can link to almost any file-based media to create clips. Linking 
to your media, instead of importing it, can potentially save you storage space.

Dynamic Media Folders can be set up to run automated media acquisition actions on the specific 
drives/folders where the original media is located. These profiles can be configured to 
automatically move and/or transcode the media to a nearline or shared storage. All media is 
processed and managed in the background while you do your editing. When ready, you can 
update the bins to refresh the metadata for each clip and point to the new path(s) on the nearline 
or ISIS storage.
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Audio Editing & Mixing

Basic audio tracks with surround sound and audio effects can be created in Media Composer and 
later sweetened in Pro Tools. This includes placing markers on the timeline to indicate where 
sound effects need to be added.

The key to maintaining a high level of interoperability between Media Composer and Pro Tools 
is to use an AAF file. This is currently the best format for transferring and reassembling the 
sequence or session composition from one application to another. 

Export the audio tracks to an AAF and perform separate exports of the media files (e.g. 
QuickTime or MXF) from Media Composer. If the destination Pro Tools system has an Avid 
video peripheral or a Video Satellite system, you can also export Avid video tracks as part of the 
AAF.

When the AAF is opened in Pro Tools, it populates a new session with all the audio media and/or 
video metadata needed to recreate any initial edits done in Media Composer. Pro Tools can also 
edit with accompanying video by either importing and viewing a QuickTime file, capturing with 
an attached video peripheral, or viewing playback from a connected Media Composer Video 
Satellite system.

During the audio editing session, you can enhance the rough audio track (also known as the 
"guide track") produced by the video editor. The markers help spot where sound effects need to 
be added. You can also view any volume automation, clip gain or pan automation information 
imported for individual tracks and easily add and manipulate break points using the Pro Tools 
editing functions.

Create other necessary audio tracks for dialog, ADR, foley, music, and sound effects in either 
mono or stereo. When the final audio sweetening session is complete, you should mix it down, 
and export both the AAF and audio media back to Media Composer.

Finishing & Special Effects

Any segments that require special visual effects processing can be sent to a separate internal or 
external facility along with the selected source media. 

Avid DS and other 3rd-party finishing systems support editing of frame sizes higher than HD and 
can be used for finishing and output in a format for digital cinema. Metadata from the editing 
functions performed in Media Composer, as well as the path to the media location for 
AMA-linked clips, are passed via the AAF/AFE.
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The finishing editor will conform the sequence (AAF/AFE/EDL) from Media Composer and 
relink to the source files at the original resolution to perform compositing, special effects and 
color grading with a deeper set of tools.

Output and Distribution

When the production is complete, the final master can be packaged and output to various 
delivery formats for cinema, TV, or web. Depending on your client's delivery specifications, you 
will need to either export final sequence with the combined video and audio, or deliver the audio 
and video components separately.

Media Composer is currently limited to HDTV broadcast and distribution requirements, however 
all the source metadata is carried over n the AAF/AFE export so that the sequences can be 
conformed in a finishing application for higher than HD delivery formats.

Output SD/HD

If you are delivering a final master for broadcast or DVD format, you can output file-based 
footage in formats as high as HD RGB 4:4:4.

Output for Web

There are a variety of digital file formats (such as QuickTime, MP4, and MXF) for web or 
mobile delivery.

Send to Air

Avid video servers handle both small and large facility requirements for playback and playout 
operations. The AirSpeed allows you to play out multiple channels at the same time.

Before you can send your sequence to the AirSpeed from an Avid editing system, you must add 
the AirSpeed server to your Send To Playback list in the Avid editing application. 

When the sequence is complete, the editor dynamically relinks to the high-res media and sends 
the final sequence to the AirSpeed playout server for broadcast or playback (this option is only 
available with Media Composer and NewsCutter).
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Multi-Distribution System

Avid’s Interplay Pulse simplifies, speeds, and unifies distribution of content to diverse channels 
and devices. Interplay Pulse links production processes with distribution to web, mobile and 
social media outlets by orchestrating workflow and automating file preparation and transcoding. 
It provides a single interface within iNEWS and/or Interplay Production to create and deliver 
content to any selected destination platform.

Workflow: Unscripted TV Production

A high amount of TV productions today fall into the realm of unscripted programs such as 
reality shows, talk shows, or lifestyle shows. These programs are typically filmed with a number 
of cameras and microphones that are positioned around the set to allow for recordings from 
different perspectives. As such, the productions can have very high shoot ratios (30/1 to 100/1) 
with every hour of programming involving up to 100 hours of raw media to process.

With the increased availability of digital cameras on the market today, both post and broadcast 
facilities need to import or link to high-resolution source material from 2K or higher camera 
formats, but continue to edit and output web and TV formats up to HD Rec. 709.

Producers typically do not need use third-party dailies or final color tools for post production of 
such programs. Avid editing systems are used for the ingest, edit, conform and final color 
grading. For productions where large amounts of footage are generated, the media is always 
edited in proxy/offline for economies in time and disk space. For the final finishing stages, the 
sequences are then transcoded to HD resolution and color-corrected for the final delivery.

The illustration below shows a typical workflow for unscripted TV shows using Avid Media 
Composer for the entire production process.
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For detailed procedures, see:

• “Checklist: File-Based Editing Workflow on a Standalone Editing System” on page 26

Acquisition of High-Resolution Media

With a file-based workflow, the footage is already in digital file format so the editing system can 
link to media directly on a camera or storage device. Avid systems support media originating 
from a variety of cameras and formats which have different codecs, color encodings, frame rates 
and raster sizes. All metadata is taken into account during acquisition and preserved along with 
the project and media information.

Since file sizes tend to be large, the real-time playback of media on the timeline may be 
compromised. As such, it may be advantageous to transcode the footage to a lower-res format for 
the rough cut, and then link back to the original media before applying the final effects and 
outputting the sequence. Some cameras can even record in MXF formats that can be handled in 
Media Composer without the need to transcode.
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The majority of high-resolution (2K+) file-based media comes from devices that have their own 
set of Look Up Tables (LUT) for advanced color management. These LUTs may come from the 
digital camera on which the footage was recorded, or from color grading done during the dailies 
processing. These LUTs need to be incorporated with the incoming media so that Media 
Composer can seamlessly apply the necessary color transformations at the appropriate stages 
during the editorial process. (Media that is pre-processed by other applications in the dailies or 
other upstream processes can be linked in Media Composer via AAFs or ALEs.)

•

Acquisition via Video Server

For broadcast and fast-turnaround media production environments, AirSpeed captures SD/HD 
feeds directly to shared Avid storage, freeing the Avid editing system for editing. This media can 
be recorded either from incoming broadcast channels or connected cameras and decks.

You can use Interplay Capture and one or more AirSpeed servers, coupled with the Avid 
Interplay Low-Res Encoder to simultaneously ingest high-res and low-res versions of the same 
media. The assets—master clips, sequences, and bins, along with the necessary AAF 
metadata—are automatically checked into the Interplay database. Clips point to both versions of 
the media. This way editors can place clips on the timeline, work efficiently using the low-res 
media, and simply switch to the high-res media for the final editing and playout.

This method of ingest captures supported file-based formats as MXF with the exception of 
XDCAM and AVC-Intra which can be handled in their native formats. 

While media is being ingested, you can use the Interplay Stream Publish service to automatically 
create streamable media that can easily be viewed over a local area network (LAN) or wide area 
network (WAN).The Interplay Transcode Service can transcode the high-res media to additional 
lower resolutions (proxies) on an as-needed basis. 

Acquisition to Shared Storage

With an Avid shared storage solution, you can quickly increase collaboration in a post facility. 
There are Avid storage solutions for facilities with standalone editing systems, as well as larger 
networked systems requiring high-resolution storage and bandwidth.

In post productions with high shoot ratios, such as reality TV, an hour of programming can 
involve perhaps 100 hours of raw media to process. This requires media to be copied from 
camera storage to an Avid ISIS shared storage. However, this means that a lot of capacity is 
required to hold media that might be discarded later in the process. To make the process more 
efficient, a low-bandwidth ISIS 2000 can be used as a “parking storage” for the source media. 
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After the editor has previewed the media and created clips of the usable shots, the required media 
can then be moved from the source files to the high-bandwidth ISIS 5000/7000 storage. Media 
can also be consolidated or transcoded to give editors better performance during playback of 
sequences. 

Linking to File-Based Media

When working with media coming directly from digital cameras or other media-creation 
applications, many editors use AMA to link to and edit their footage. Editing stations connected 
to a digital camera or card reader can link to almost any file-based media to create clips. Linking 
to your media, instead of importing it, can potentially save you storage space.

Dynamic Media Folders can be set up to run automated media acquisition actions on the specific 
drives/folders where the original media is located. These profiles can be configured to 
automatically move and/or transcode the media to a nearline or shared storage. All media is 
processed and managed in the background while you do your editing. When ready, you can 
update the bins to refresh the metadata for each clip and point to the new path(s) on the nearline 
or ISIS storage.

Audio Editing & Mixing

Basic audio tracks with surround sound and audio effects can be created in Media Composer and 
later sweetened in Pro Tools. This includes placing markers on the timeline to indicate where 
sound effects need to be added.

The key to maintaining a high level of interoperability between Media Composer and Pro Tools 
is to use an AAF file. This is currently the best format for transferring and reassembling the 
sequence or session composition from one application to another. 

Export the audio tracks to an AAF and perform separate exports of the media files (e.g. 
QuickTime or MXF) from Media Composer. If the destination Pro Tools system has an Avid 
video peripheral or a Video Satellite system, you can also export Avid video tracks as part of the 
AAF.

When the AAF is opened in Pro Tools, it populates a new session with all the audio media and/or 
video metadata needed to recreate any initial edits done in Media Composer. Pro Tools can also 
edit with accompanying video by either importing and viewing a QuickTime file, capturing with 
an attached video peripheral, or viewing playback from a connected Media Composer Video 
Satellite system.
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During the audio editing session, you can enhance the rough audio track (also known as the 
"guide track") produced by the video editor. The markers help spot where sound effects need to 
be added. You can also view any volume automation, clip gain or pan automation information 
imported for individual tracks and easily add and manipulate break points using the Pro Tools 
editing functions.

Create other necessary audio tracks for dialog, ADR, foley, music, and sound effects in either 
mono or stereo. When the final audio sweetening session is complete, you should mix it down, 
and export both the AAF and audio media back to Media Composer.

Conform and Output

If you intend to conform and output in HD, you can relink your sequence to the source media. 
After adding the necessary visual effects and finishing touches, the sequence is rendered to the 
required delivery format.

Output and Distribution

When the production is complete, the final master can be packaged and output to various 
delivery formats for cinema, TV, or web. Depending on your client's delivery specifications, you 
will need to either export final sequence with the combined video and audio, or deliver the audio 
and video components separately.

Media Composer is currently limited to HDTV broadcast and distribution requirements, however 
all the source metadata is carried over n the AAF/AFE export so that the sequences can be 
conformed in a finishing application for higher than HD delivery formats.

Output SD/HD

If you are delivering a final master for broadcast or DVD format, you can output file-based 
footage in formats as high as HD RGB 4:4:4.

Output for Web

There are a variety of digital file formats (such as QuickTime, MP4, and MXF) for web or 
mobile delivery.

Send to Air

Avid video servers handle both small and large facility requirements for playback and playout 
operations. The AirSpeed allows you to play out multiple channels at the same time.
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Before you can send your sequence to the AirSpeed from an Avid editing system, you must add 
the AirSpeed server to your Send To Playback list in the Avid editing application. 

When the sequence is complete, the editor dynamically relinks to the high-res media and sends 
the final sequence to the AirSpeed playout server for broadcast or playback (this option is only 
available with Media Composer and NewsCutter).

Multi-Distribution System

Avid’s Interplay Pulse simplifies, speeds, and unifies distribution of content to diverse channels 
and devices. Interplay Pulse links production processes with distribution to web, mobile and 
social media outlets by orchestrating workflow and automating file preparation and transcoding. 
It provides a single interface within iNEWS and/or Interplay Production to create and deliver 
content to any selected destination platform.

Editing on Interplay

The exchange process between Avid audio and video editing systems can be facilitated with 
Avid interconnectivity solutions. Media Composer, NewsCutter, and Pro Tools systems support 
integration with Avid’s Interplay asset management system and shared storage.

Both post and broadcast facilities can configure a multi-resolution workflow, that allow 
producers, assistants and editors to log, mark and edit large amounts of material quickly and 
accurately. With Interplay Access, anyone can search or browse folders that organize assets from 
across all workspaces. Interplay tracks the locations of assets, including all resolutions of a 
master clip, and allows you to easily pull them into your project. 

The following illustration shows how a facility can use the Avid Interplay infrastructure to 
manage and efficiently edit large amounts of footage. This post production environment consists 
of Avid video, audio and finishing editing stations, Avid ISIS shared storage, and an Avid 
Interplay Production driving the media management between the Avid editing systems.
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Editing with File-based Formats

The latest version of Interplay introduces typical media management functions (e.g. deletion) to 
enhance your production workflow when working with media in popular digital formats. All 
AMA-linked clips will be managed in the same robust manner as MXF Avid-compliant OPAtom 
files. Similarly, all media, whether acquired traditionally or linked by AMA, will be displayed in 
a single window in the Media Tool. 
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Audio Editing & Mixing

For the audio mixing and sound effects process, the Avid Media Composer editor can export the 
final sequence as an AAF and check it in to the Interplay database. The sound editor using Avid 
Pro Tools can import the sequence and relink to the audio files to finalize the sound editing. The 
completed mix can then be checked back into Interplay and imported back into the video editing 
application for the final synchronization.

• When connected to an Interplay system, Avid video editing systems can check in/out 
projects, sequences, and media from Interplay, created for or by Pro Tools.

• When equipped with the Pro Tools Interplay Integration option, Pro Tools can interact 
directly with Avid Interplay to export the session and any new media back to the sequence 
on Interplay. 

- Open sequences directly from Interplay 

- Send sequences directly to 3rd-party playback servers for live playback (Interplay 
Transfer option and Pro Tools Send to Playback web service required).

For more information on audio-video editing workflows, see the Audio-Video Editing Workflow 
Guide and the Pro Tools Avid Interplay Guide. 

Special Effects & Finishing

When a sequence is ready for the effects and finishing process, a Media Composer editor can 
export an AFE and check it in to the Interplay database. The Symphony editor checks-out the 
AFE, and conforms and relinks to the high-resolution media. After adding the necessary visual 
effects and finishing touches, the sequence is rendered to the required delivery format and all the 
necessary project files and new media are checked back in to Interplay. If the sequence needs to 
be sent back to Media Composer, it should be checked back in.

Checklist: File-Based Editing Workflow on a 
Standalone Editing System

This section outlines the basic workflow for linking and editing file-based footage on a Media 
Composer system. 

n If you are editing stereoscopic media, you should also refer to the Avid Stereoscopic 3D Editing 
Workflow Guide for specific guidelines pertaining to acquiring and editing 3D media.

Follow these steps in the order that they are listed, and return to this checklist each time you 
complete a step. 
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Step Refer to this section

Before you begin:

 Understand AMA and the most efficient way to link 
to and edit high-resolution (2K+) files.

“Considerations when Editing with 
File-Based Media” on page 10.

 There are a number of ways to edit your production 
with Avid tools. Read about the workflow that best 
applies to your project.

“Workflow: Digital Cinema Production” on 
page 14

or

“Workflow: Unscripted TV Production” on 
page 19.

 Learn about high-resolution files and how they are 
handled in Media Composer.

“What's the Difference between Resolution 
and Size?” on page 34.

“What is Color Management?” on page 36.

 Avid’s new dynamic media folders and background 
transcode/consolidate processes bring much more 
efficiency to the media acquisition stage. Learn how 
you can set up media service profiles to automate 
these functions.

“The Avid Media Access (AMA) Workflow” 
on page 64.

 Some media formats are supported natively in Media 
Composer and can be linked or ingested directly. 
Other formats that are not natively supported will 
need supporting AMA plug-ins developed by the 
camera manufacturers.

“Viewing Installed AMA Plug-ins” on 
page 68.

 Install the necessary AMA plug-ins on your 
workstation. 

Go to avid.com/ama to install the latest 
plug-ins.

 Install QuickTime. Go to the Apple web site to download 
Quicktime.

 Create a project. ”Creating a New Project” in the help.

 Set your project frame size. ”Setting the Project Format to Accomodate 
Variable Resolutions” in the help.

 Set your project color space. ”Setting the Project Color Space” in the 
help.

http://www.avid.com/US/products/Avid-Media-Access/Plug-ins
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 Dynamic Media Folders can be set up to run 
automated media acquisition actions on the specific 
drives/folders where the original media is located. 
Profiles can be configured to automatically move 
and/or transcode the media to a nearline or shared 
storage. If you intend to use the DMF and 
Background Transcode services, make sure that you 
enable them.

n These services have certain processing 
requirements for your system.

“Starting and Stopping Avid Background 
Services” in the Media Composer Readme.

Acquiring your Media:

 Enable Avid Media Access (AMA) settings. “Selecting the AMA Settings” on page 68.

 Set the storage location for any transcoded or 
consolidated media.

 For media coming directly from the camera:

 Connect any camera or portable media drive to 
your system. The device will be recognized as 
a volume on your system from which you can 
read the media files. 

or

“Copying File-Based Media to a FireWire or 
Network Drive” on page 70.

 Copy the media from the camera to a 
designated folder on a storage device. This can 
be done with automated profiles.

“Creating Dynamic Media Folders” on 
page 71.

 If you need to use media that has been pre-processed 
on a Dailies system:

 MXF media: Place it in the Avid MediaFiles 
folder on your Avid editing system or a shared 
storage.

 Quicktime media: Place it in a designated 
folder of your choice.

 Place the AAF/ALE and any LUTs created by 
the dailies application in the same folder with 
their associated media.

Step Refer to this section
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 If you have any additional metadata for your clips, 
such as additional changes to the media done by 3rd 
party applications, you can import this information 
using log files (ALE).

 Link to all footage that you require.

You must make sure to keep your files organized 
into bins that will allow you to easily relink to the 
source media during the finishing stages.

“Linking Media with AMA” on page 78.

 To acquire MXF media created by a dailies 
application, use an AAF to link to the media.

 To prepare the media for the editorial process, you 
may want to apply certain changes, such as color 
adjustments, directly on the source media.

These changes should be applied to the AMA clips 
rather than the transcoded clips. This way, these 
source changes will be available when you conform 
and link back to the AMA clips.

“Changing Source Properties on a Master 
Clip” on page 37.

 Set the appropriate color space for your 
acquired media.

“Setting the Color Properties of Acquired 
Media” on page 47.

 For certain media types, you can also use the 
respective AMA plug-in to adjust the color 
settings. If the plug-in is installed on your 
system, there will be additional tab called 
AMA Source Settings in the Source Settings 
dialog box.

 Apply (or ignore) custom color metadata 
attached to your media.

“Using Color Decision Lists (CDLs)” on 
page 50.

 If you want to remove unnecessary areas of 
the image, you can reframe it by setting new 
dimensions.

“Reframing your Media” on page 39.

 If necessary, reformat your media to fit the 
project frame size.

“Reformatting the Media to fit the Project 
Frame Size” on page 44.

Consolidating or Transcoding your Media:

Step Refer to this section
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 Linking to high resolution files via AMA can be 
both processor and storage intensive. If you require 
better performance, you may want to consolidate or 
transcode your media and work with 
lower-resolution (proxy) versions of the media.

“Editing with Low-Resolution Proxy Media” 
on page 51.

 You can automate the consolidate/transcode process 
to run in the background by setting up automated 
profiles for the file folders where you placed your 
media.

“Creating Dynamic Media Folders” on 
page 71.

Editing your sequence:

 Perform the offline editorial using the proxy clips.

 If you need to perform any reframing or panning on 
your clips, it must be applied on the proxy clips in 
the bin. The sequence must then be refreshed to 
update these changes onto the clips on the timeline.

“Reframing your Media” on page 39.

“Panning a Shot” on page 43.

“Reformatting the Media to fit the Project 
Frame Size” on page 44.

 You can create some basic audio tracks with 
surround sound and audio effects in Media 
Composer and send these tracks to Pro Tools for 
sweetening.

“Exporting Sequences to External 
Applications” on page 61.

 When the final audio sweetening session is 
complete, it is mixed down, and both the AAF 
and audio media are exported back for use in 
Media Composer.

Finishing your sequence:

 When you are ready to move on to the finishing 
stage, save your sequence and relink to the source 
AMA clips.

“Relinking to Source Media for Conform 
and Finishing” on page 53.

 If necessary, transcode your sequence to an HD 
resolution required for the final delivery. The 
transcoded sequence will automatically be linked to 
the new transcoded media.

 Color correct and apply effects to your clips.

 Add the necessary titles to your sequence.

Step Refer to this section
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 If you need to master the entire sequence in another 
application or apply custom effects on certain 
segments, export the sequence or necessary 
segments as an AAF/AFE.

You will also need to send the corresponding source 
media at the best quality.

“Exporting Sequences to External 
Applications” on page 61.

 If the finishing system will need to relink to 
the original camera essence, then you need to 
relink to the AMA-linked clips before 
exporting the AAF/AFE.

n If you are working with high-res files, 
do not use the option to extend handles 
beyond the master clip edges.

“Relinking to Source Media for Conform 
and Finishing” on page 53.

 If the finishing system will use the same HD 
media, you should first make a copy of the 
sequence, move it to its own bin, decompose it 
(with handles as desired), select ALL master 
clips, and export as ALE with appropriate 
columns visible in the bin.

Outputting your sequence:

 Render the effects in your final sequence to avoid 
any dropping of frames during the output process.

 Output the final sequence to the appropriate medium 
for delivery.

 If you want to create a master with a different 
aspect ratio than the project setting, you can 
specify mask margins on the output frame in 
order to change the dimensions of the output 
image.

“Setting the Mask Regions for the Final 
Output” on page 55.

 If you have a HD sequence and need to output 
to SD, then you need to first downconvert the 
project.

 Output your project to a tape deck or disc 
recorder, 

or

 Export your project to a media file such as a 
QuickTime movie.

“Exporting Sequences to File” on page 59.

Step Refer to this section



2 Working with High-Resolution Media

The following diagram shows the different points in the pipeline where you will be able to set 
your image format properties for display and output. It also indicates the places where the color 
transformations are applied in order to maintain the proper color appearance from acquisition to 
output.

1. Open/Create a Project

Media will originate from different sources such as file-based cameras, film frames scanned to 
files, SD or HD tapes, and even computer-generated motion graphics. Each of these media 
sources can have arbitrary sizes, resolution, frame rates, compression and color encoding (color 
model, gamma, bit depth, etc.). 
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Media Composer gives you the ability to capture, import, or link to media coming from different 
sources, regardless of their resolution, and mix them freely in the timeline. Of course, all this 
media needs be output to one frame size, hence it is important to set a common frame size in the 
Avid editing application.

The application also needs to use a common color space for all media in the project so that a 
common transformation model is applied to all incoming media.

Step 2. Acquire and Interpret Quality of the File-based Footage

When linking to media, you have access to all of the pixels in the source image. However, to fit 
the final delivery format, you need to set the project size so that media of different sizes and 
formats can be reformatted to specification.

File-based media can be linked or imported. Linking to media via AMA allows you to view the 
image in its original format. Importing the media reformats the image to the frame size of the 
project. If you link your clips, you will be able to view the media in its full resolution and thus 
have greater flexibility when mapping the media to the project settings. You can use the full 
image or select a region to be framed, and then choose how to format the media to the SD or HD 
project size.

When the master clips are created in the bin, any associated color metadata (coming either from 
the camera or other upstream processing) can also be detected and applied. Media Composer 
keeps all source metadata with the master clips. This metadata will also carry over in the 
AAF/AFE export so that the sequences can be conformed in a finishing application for higher 
than HD delivery formats.

Step 3: Edit the Sequence

For the editing process, the project format in Media Composer is currently restricted to HDTV 
broadcast and distribution requirements. Once a clip is placed on the timeline, it will reformat to 
fit the media conversion settings that you have chosen for your project. 

For further efficiency during the editorial, there is the option to transcode to a lower resolution 
(proxy).

Step 4. Apply Effects

Any effects applied to clips on the timeline will be applied to the area of the image displayed in 
the viewer. These will be processed on-the-fly during playback, and any precomputes will be 
rendered to the disk storage. (Note: Processing is done using the settings in the Media Creation 
dialog).
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Step 5: Output the Final Sequence

Avid editing applications give you the ability to output your sequences to a format suitable for 
TV broadcast or DVD/BluRay.

For now, sequences can only be output to the Rec 709 color space which is the standard for 
HDTV. This color space can then be changed at the final output stage to match a different 
delivery format. For example if you've been working in an HD format, you can switch to 
standard-definition (SD), and the colors will automatically be converted for an ITU 601 color 
space and any effects recomputed if necessary.

What's the Difference between Resolution and Size?

Quite often, the terms resolution and size are used interchangeably. There is a difference between 
the two and it's important that we clarify the meaning of each one so that you understand how 
your media is formatted in the editing application.

The resolution of the media refers to the number of pixels that compose the image. Naturally, 
the more pixels in the image, the higher your resolution will be, and the better the quality of the 
image. The resolution is typically defined by the number of pixel columns (width) by the number 
of pixel rows (height).

HD images are usually 1920 by 1080, and high resolution images are typically 2K and above. 
These resolutions vary depending on the camera that shot the footage. For example, an ARRI 3K 
image is 2880 x 1620, whereas a RED 3K image is 3072 x 1728.

The size refers to the physical space that the image occupies in a particular display or print area. 
Size is simply used to provide a common reference for the framing of images of different 
resolutions. 

Let's use the analogy of a digital photo that you want to have printed and framed. Your photo is 
shot at a high quality resolution e.g. 3264 x 2448 and you want to print it to fit in a 5” x 7” 
picture frame, as well as in a 15” x 20” frame. When the photo is enlarged to fit in the larger 
frame size, each pixel increases in size. Thus, when looking at each of the photos up close, the 
image in the smaller frame will be much sharper. The number of pixels, however, remains the 
same. They are just more tightly packed in the smaller frame size.
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There will be cases when the image is required to fit into an frame size that is of different 
dimensions than the original image. For example, if the 5” x 7” photo had to be framed into a 
6” x 9” picture frame, it could either be cropped or left as is and framed with a matte. 

Similar choices can be made when editing video. The examples below show how an image can 
be framed in the Avid editing application. An image can be rescaled, cropped, or padded to fit 
the project frame size. The pixels in the image are simply shrunk or enlarged as necessary.

5”

7”

15”

20”

Crop Matte

6”6”

9” 9”
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What is Color Management?

Since most cameras record at a high precision, it would be ideal to preserve the maximum 
precision and color range right through the editing process. Color management enables you to 
retain the colors of the original images and maintain that color appearance during editing. 

During acquisition (either by baseband capture, import or link to file), Media Composer will 
automatically detect the color encoding of the footage and will allow you to choose the color 
space that best matches the footage. Media Composer will perform the necessary color 
transformation of the footage in order to map the colors to internal application functions. 

The color space that you choose depends on the final delivery format. For this release, final 
output is intended for TV broadcast in HD. Therefore, color mapping is limited to Rec. 709.

The original color encoding will remain with the master clip metadata for use throughout the 
editing pipeline, ready to translate the image's colors for other devices at any given point (e.g. for 
viewing on the monitors). Part of the color encoding includes "look" tables (or LUTs) that can be 
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passed along with the media to ensure that a consistent color is applied to all related footage. The 
color management system will take the colors in an image and map them as accurately as 
possible to the color model chosen for the editing process. This color mapping is either done 
'on-the-fly', or can be rendered to new media after any effects are applied. 

Color mapping also takes place on each device where you view the footage. The Avid system can 
be connected to a variety of monitors, and each model will display colors differently. For 
example, say that a certain color coming from a digital camera is turquoise blue (represented by 
RGB numbers R75, G201, and B220), but appears closer to sea green on a monitor. The color 
management system needs to translate the RGB numbers to the equivalent numbers required by 
the monitor in order to preserve the turquoise blue appearance. This translation is performed by 
setting the appropriate color profile on the monitor. (Note: For this release, only Rec. 709 color 
profiles will be supported on the viewers and external monitors.) If you want to simulate the 
colors as they will be projected for final delivery, then you can must calibrate your external 
monitor accordingly. 

Changing Source Properties on a Master Clip

To ease the editorial process, Avid provides a number of tools to preview the original essence 
from the camera and make adjustments to the incoming media or its metadata. Any adjustments 
made to the master clips are applied as source adapter effects. 

Import or AMA-link to your file-based media in the usual manner. After media has been 
acquired and the master clips have been created in the bin, you will be able to view and adjust the 
media properties from a single Source Settings view. 
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The Source Settings dialog box detects the properties of the source media based on the metadata 
that was found with these files. It allows you to quickly see the properties of the input files and 
make changes if necessary.You can also view any framing applied on the image, as well as a 
histogram showing the range of colors in the image.

If there is an AMA plug-in installed on your system for this media format, then an additional 
AMA Source Settings tab will be available. Any settings on this tab will be applied before the 
Color Encoding tab.

The Source Settings dialog box allows you to:

• set the aspect ratio of the media

• set the color space of the media

• apply specific color transformations to the source media

• choose the way you want to format the source into the current project frame size

• select a smaller area of the overall image size to be displayed in the project frame

n Some of these settings can be set directly in the bin columns.

Imported clips will already be resized to the project size and aspect ratio. However, it is still 
possible to reframe or reformat the imported clip. 

A Spatial Adapter effect is applied either when the clip is reframed, or reformatted to fit within 
the project frame size. A Color Adapter effect is applied when a color transformation applied to 
the clip. When the clip is placed on the timeline, any of these changes will be indicated as 
adapter effects and will display as green dots on the clip. These effects can be modified with the 
Effect Editor and rendered to allow for smooth playback and output.



Reframing your Media

39

Reframing your Media

For various reasons, it is common practice to shoot at a higher resolution than the final output 
intentions. Framing charts, that define the dimensions of the final output, have been developed 
for camera viewfinders so that the camera people can keep the proper perspective in view while 
filming. 

The framing chart used during the onset shoot is usually filmed as the first frame of the shot. 
Some digital cameras even include these framing parameters in the file metadata that is passed 
through to the Avid editing application. During post production, these framing parameters serve 
as guidelines for the editing process, and this intended action area can be automatically framed to 
the project frame size.
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During the onset shoot, certain objects (such as lights, flags and other on-set equipment) may 
inadvertently be recorded within the main viewing area. As part of the dailies process, these 
objects may be trimmed out from the region of the image that is presented to editorial. If not, 
then the post editor is required to crop out and reframe the image as necessary. 

If the framing parameters were included in the media metadata, then the Framing view will 
reflect the same area used during the onset shoot. If necessary, the editor can adjust these 
dimensions manually. 

Clips are reframed by applying a spatial adapter on the clip in the bin. The Source Settings dialog 
has a FrameFlex tab where the dimensions of the framing box can be adjusted. The area within 
the framing box is what will finally be fit into the project frame when the clip is used in a 
sequence. 

The reformatting settings for each clip are saved in the bin. When the clip is dropped on the 
timeline, a green dot appears on the clip to indicate that a source adapter effect has been applied. 
The application accesses the original image and applies the formatting during playback. Effects 
are applied and rendered based on these settings.

n For clips that have already been used in a sequence, the sequence can be refreshed to frame to 
the new dimensions.

To set the framing dimensions:

1. Select one or more clips in the bin, right-click and choose Source Settings.

2. If the image viewers are not displayed in the Source Settings dialog, click the Show Viewers 
checkbox.

3. Select the FrameFlex tab.

The framing options display with the framing box outlining the full image.

n If framing parameters were passed from a camera vendor that is an Avid partner, then the 
framing view used on set may be displayed in the viewer.

4. In the FrameFlex box, adjust the Framing parameters to set the new dimensions of the 
framing box.

Option Description

Same size as project’s raster dimensions Sets the framing box at a 1:1 ratio with the project 
frame size.

Frame aspect ratio Changes the size of the framing box according to 
the selected aspect ratio.
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X Reposition the framing box along either the X or 
Y axes.

Y

Size Resize the framing box proportionally. 

Color Set color of framing box outline in the viewer.

Reset Resets the framing to the original size.

Reformat

Stretch Stretches the image (disproportionally, if 
necessary) to fill the project frame. 

Pillarbox/Letterbox Scales the image proportionally until either the 
height or the width extends to the project frame. 
Black bands will appear on the sides (Pillarbox), 
or on the top and bottom (Letterbox) in order to 
pad the empty areas of the frame.

Centre Crop Scales the image proportionally to fill the project 
frame. Areas that fall outside of the project frame 
will be cropped.

Centre, Keep Size Centers the image in the viewer without 
modifying its original size. Areas that fall outside 
of the project frame will be cropped.

Revert Reverses any changes you made since the last 
time the Apply button was clicked. 

Apply Applies all selections that you made so that you 
can see the changes in the viewers.

Option Description
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5. The bottom viewer displays the framed area as it would appear within the actual project 
frame. Refer to “Reformatting the Media to fit the Project Frame Size” on page 44 for more 
details on the choices that you have.

6. Click Apply.

The new framing of the image will be applied when you drop the clip in the Source viewer 
or on the timeline. A green dot on the clip in the timeline indicates that spatial changes (in 
the form of a spatial adapter effect) have been applied to this clip. 

7. If you had placed your clip on the timeline before doing the reframing, you can refresh your 
timeline with the changes—see “Refreshing Clips to Use Current Clip Attributes” in the 
Help.

8. If you want to make further changes to the framing box from the timeline, open the spatial 
adapter effect for this clip—see also “Panning a Shot” on page 43.
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Panning a Shot

If you want to pan and scan over a segment of video, you need to apply a FrameFlex source 
adapter to the clip in the bin. When the clip is placed on the timeline, a green dot will appear on 
it and you can open the Effect Editor to change the framing box and animate it for the necessary 
duration—see “Reframing your Media” on page 39.

If the clip was already part of the sequence before you applied the FrameFlex source adapter, 
then you will need to refresh the sequence so that inherits the newly-set attributes from the clip in 
the bin—see “Refreshing Clips to Use Current Clip Attributes” in the Help.

If the clip still references the source media, you will see all the pixels in the image. You simply 
have to set the framing box over the area that is required in the focus and make sure that the box 
shifts to a new position in subsequent frames in order to follow the important action. These 
positions should be keyframed to create the effect of a "pan" shot.

To animate the framing parameters:

1. Select the clip on the timeline and click the Effect Mode button.

The Effect Editor displays.

2. Select and expand the FrameFlex effect.

The Record viewer becomes your workspace to adjust the framing parameters.

3. screen grab of UI - check enabler to bypass when clicked and ALT-CLICK to Reset
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4. Click in the position bar below the Effect Preview monitor at the point in the effect where 
you want to add the keyframe. 

The position indicator moves to that frame.

5. Do one of the following to add a keyframe:

t In the Effect Preview Monitor toolbar, click the Add Keyframe button .

t Manually adjust the framing box in the Record viewer.

For example, drag the handles on the corners of the image to resize it. The Avid editing 
application automatically creates a new keyframe.

Reformatting the Media to fit the Project Frame Size

In the source settings dialog box, you have the option to reformat the entire image or just the area 
within the framing box to the current project format.

n The reformat image option is also available in the Effect editor if you need to apply a change to 
a clip on the timeline.

To reformat the image to the project frame size:

1. In either the bin or on the timeline, select the clip that you want to change, right-click and 
choose Source Settings.

The Source Settings dialog box displays with the viewer showing the first frame of the clip 
with the current framing dimensions.

2. Select the FrameFlex tab.

3. Select the appropriate Reformat option.

When using media of a different format from the project format, you can specify how the 
media will be converted in the application by using one of the modes below:

Reformat Options Descriptions

Stretch Stretches the image (disproportionally, if necessary) to 
fill the project frame. 

Pillarbox/Letterbox Scales the image proportionally until either the height or 
the width extends to the project frame. Black bands will 
appear on the sides (Pillarbox), or on the top and bottom 
(Letterbox) in order to pad the empty areas of the frame.

Centre, Keep Size Centers the image in the viewer without modifying its 
original size. Areas that fall outside of the project frame 
will be cropped.
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The results of your changes will be displayed in the bottom viewer.

Areas of the image that fall outside of the project frame size, will be cropped. On the other 
hand, if the image is smaller than the project frame size, it will be padded with black.

Once a clip is placed on the timeline, it will reformat to the project frame size according to 
the media conversion settings that you have chosen. Note that any reformatting options are 
processed on the fly during playback and do not affect the source clip. 

Centre Crop Scales the image proportionally to fill the project frame. 
Areas that fall outside of the project frame will be 
cropped.

Reformat Options Descriptions

16:9

STRETCH

4:3

CENTRE CROPCENTRE, KEEP SIZE LETTERBOX/PILLARBOX

SOURCE MEDIAPROJECT FRAME SIZE
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4. Click Apply.

The new formatting of the image will be applied when you drop the clip in the Source 
viewer or on the timeline.

Example of Reframing and Reformatting

The following example shows a 2K image with a framing box set around the desired area of the 
image. The application first crops out the unwanted area and then fits the image within the 
project frame size (using the letterbox/pillarbox option selected by the editor).

Defining the framing box

Original 2K image

Project frame size (HD)

Framing box
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Reframing and reformatting applied

Setting the Color Properties of Acquired Media 

The application preserves all color metadata from the acquisition process. This includes color 
information embedded in the raw footage, as well as in accompanying conversion tables (LUTs, 
CDLs) that can be associated along with the media to ensure that a consistent color is applied to 
all related footage. This information is saved with the clip in the bin. 

For other common digital cameras, Avid provides a standard set of camera conversion tables that 
will map the camera color values to the color space used in Media Composer. . 

n Camera vendors that have partnered with Avid also supply AMA plug-ins for specific camera 
formats. Refer to “Using AMA Plug-Ins” on page 88 for more details on using these formats in 
Media Composer.

A look-up table (LUT) is a file that contains a conversion table used to map an input color value 
to an output color value. LUTs are used for the following reasons:

• To ensure a standardized color output value across different devices such as computer 
monitors, broadcast monitors, and film projectors. 

• To offer flexibility in editing and post-production when working with media from different 
sources or shot with different cameras. 

• To convert logarithmic media files to linear format prior to editing and applying effects.

Project frame size (HD)

Clip reformatted 
and padded to fit
project frame size
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• For creative or artistic purposes to obtain a particular “look and feel” to a scene. 

• To determine how the color data of the final image will be displayed.

Media Composer automatically detects color management attributes encoded in the camera 
format. The camera manufacturers need to structure their metadata according to the Avid 
requirements to allow for these values to be passed on to the editing application. Refer to the web 
sites of your camera manufacturers to find out if their file formats include the necessary color 
management attributes.

For more information on other ways that custom transformations that can be applied to your 
media, see “Using Color Decision Lists (CDLs)” on page 50.

To change the color encoding of the source media:

1. In the bin, select one or more clips that you want to change, right-click and choose Source 
Settings.

n Certain file formats that have an AMA plug-in installed on your system will also reveal an AMA 
Source Settings tab. In the case of RED media, for example, the color space adjustments should 
be made on this tab.

2. Select the Color Encoding tab.

The Source Settings dialog box displays with the viewer showing the first frame of the clip 
with the current color encoding.
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Color Encoding Parameters Descriptions

Source color space For some known camera formats, the application reads the 
color space metadata within the source media, and displays 
the most appropriate color space. If you know the color 
space of the media you can select it here and this 
information will remain with the clip for other downstream 
processes. 

If you click the Auto button, this color space will be 
applied as a transformation to the media when the clip is 
used in a sequence.

You may leave it as Unknown if you do not know the color 
space of the media. In this case, the application will leave 
the colors as they are.
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3.  If you know what color transformation you want to apply, select it from the Color 
Transformation list, and click the + button.

The transformation is added to the list and applied to the image in the viewer.

4. You can add more than one transformation if necessary, and change the order in which they 
are applied by selecting and dragging the transformation up or down in the list.

Transformations are applied cumulatively starting from top to bottom.

5. Click OK to close the dialog box.

When clips are viewed in the Source monitor or dropped on the timeline, any associated look 
files (LUTs, CDLs, etc.) are also considered when the color transformation is applied. This 
will be reflected when the clips are played back. You can also choose to apply these changes 
to any new media is generated through transcode, consolidate or mixdown.

Using Color Decision Lists (CDLs)

A CDL (color decision list) is a simple color transformation format specified by the American 
Society of Cinematographers (ASC). It is a way to communicate color renditions between 
equipment and software from different manufacturers, using four critical parameters—slope, 
offset, power and saturation. 

[list of color transformations] To apply an additional color transformation to the media, 
select an option from the drop down list and click the Add 
button. You can add more than one color transformation to 
your media.

Delete Select a transformation from the list of applied 
transformations, and click Delete to remove it.

Auto Clicking this button will apply the assigned (detected) 
Source color space to the media.

Bypass all color transformations Ignore all color encoding settings. This may be required if 
you need to send a particular segment for special effects 
processing without any transformations that you have 
applied during the editing process.

Revert Reverses any changes you made since the last time the 
Apply button was clicked. 

Apply or Apply All Applies the settings to all clips that you selected in the bin. 
Color changes will be visible in the viewer.

Color Encoding Parameters Descriptions
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CDLs are used for the following reasons:

• to convey the intent of the Director of Photography (decisions made on-set)

• transferring primary color grading values from dailies or media preparation stations to the 
offline editing stations

• as a starting point for finishing stations to perform the final grading

Primary color grading can be performed as one of the pre-post functions on dailies systems and 
then passed on to the offline editing system. If the editing station uses MXF media, these colors 
are already applied. However, if the editor decides to use the original media, then he or she may 
want to read these values via the CDL and apply them to the master clips.

These CDL values are imported via an EDL or ALE (in the ASC_SOP and ASC_SAT 
parameters). They are stored with the clip metadata and can be exposed in the bin columns. 
When you export your sequence/segment as an AAF/ALE/EDL, these values are included and 
can be sent along to the effects specialist along with the associated media.

To enable the reading of CDL parameters:

1. Select the Settings tab.

2. Double-click Color Management from the list.

3. Select Use CDL values from ASC_SOP and ASC_SAT bin columns when available.

Any values attached to the clip from the EDL/ALE will be applied as a color transformation 
and can be seen in the Source Settings for the clip.

4. Any clips with CDLs to which you link will automatically apply the CDL values. For clips 
that were already linked, you will need to open the Source Settings dialog and click the Auto 
button on the Color Encoding tab. Alternatively, you can select the CDL option from the 
Color Transformation list.

n CDL values can be copied from one ASC_SOP bin column of a clip and applied to another. The 
changes will not be reflected on the receiving clip until you open the Source Settings dialog and 
click the Auto button.

Editing with Low-Resolution Proxy Media

AMA offers the advantage of allowing you to transcode material to a lower resolution at any 
stage of the process. Most production facilities transcode all their footage up front in order get 
the best performance when previewing the footage for the editorial. Transcoding to DNxHD 36 
is an acceptable quality for editing your sequences. However, if you plan on doing finishing work 
to your sequence, it's advisable to transcode your final sequence to DNxHD 145, DNxHD 220, 
or DNxHD 220x.



Editing with Low-Resolution Proxy Media

52

To build your sequence with transcoded clips:

1. Transcode your clips using either the manual or background transcode process.

For the transcode, right-click the sequence and transcode to the offline resolution including 
handles. 

In the Consolidate/Transcode dialog box, select:

- Create new sequence

- Create new clips

- Apply color transformation (if color space adjustments were made on the AMA-linked 
clips and you want them to be applied when the new media is generated)

- Apply reformatting option (if the AMA-linked clip was reframed/reformatted and you 
want it to be reflected when the new media is generated)

Color and reframing options do not have to be “baked in” to the media if you want the 
flexibility to make further transformations to the clips within the sequence. Any changes 
made to the proxies will be then be reflected when you relink to the source files.

When the sequence is transcoded, new media is created for each of the clips in the sequence. 
This media is referenced by .new clips that will appear in your bin. Similarly, a new 
.transcoded sequence will also appear in your bin.

2. Move all the *.new clips to a new bin and rename the bin suitably. Separating the AMA and 
transcoded clips into different bins will allow you to link back to the source AMA clips more 
easily later in the editorial process.

3. Close the bins with the AMA-linked clips.

4. Load the transcoded sequence onto the timeline for the fine-tune editing.

Once you start editing with the low-res proxies, any color adjustments you make to the 
proxy clips on the timeline are not transferred back to the original AMA clips. Therefore, 
apply source-side color adjustments directly to the proxy clips in the bin and then refresh the 
sequence in order to propagate the adjustments to the sequence. These adjustments will then 
be available when you link to the AMA clips. For procedures on how to refresh your 
sequence, see “Refreshing Sequences to Use Current Clip Attributes” in the Help.

For example, there may be a case where you need to reframe a certain segment of your 
sequence or do a pan and scan in order to follow the important action. Since the clips are 
already used within the sequence, you need to add the framing adapter on the proxy clips in 
the bin. You must then make sure to refresh your sequence in order to propagate the framing 
parameters to the sequence. This will allow you to do further adjustments on the framing 
box directly on the timeline in order to change it’s size and/or position from one frame to the 
next.
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5. After the editing process is complete, you may want to switch back to the high-resolution 
sources before outputting your final sequence—see “Relinking to Source Media for 
Conform and Finishing” on page 53.

Relinking to Source Media for Conform and 
Finishing

If you built your sequence with AMA-linked clips and switched to lower-resolution clips for the 
editorial, you will need to switch back to the high-resolution sources if you want to output your 
final sequence at a better resolution.

n The relink operation can be done automatically if you are in an Interplay environment. Refer to 
”Using MultiRez and Dynamic Relink” in the online help.

To relink to the original media:

1. Close the bin(s) with the transcoded clips and open the bin(s) with the AMA-linked clips.

2. Select the edited sequence, press the Shift key and select all the AMA-linked master clips in 
all the open bins. 

n You don’t need to know which clips were used in your sequence. By selecting all the AMA clips, 
the application will automatically relink the transcoded clips on your timeline to their partnering 
AMA master clips.

3. Right-click on the edited sequence and select Relink from the menu. 

4. In the Relink dialog box, choose:

- Relink selected items to: Selected items in ALL open bins

- Create new sequence.

5. Set any other options as necessary and click OK to relink.

A new relinked sequence containing the AMA-linked clips will appear in the bin.

6. Load this relinked sequence onto the timeline for the conform. 

At this point, you can continue the finishing process with the AMA-linked clips, or you can 
transcode your sequence to an HD resolution that is suitable for output.

7. For the transcode, right-click the sequence and transcode to the online resolution including 
handles. This will transcode only the required media and create a new sequence with links to 
the newly transcoded clips. You can then load this transcoded sequence onto the timeline for 
the final stages.
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Linking to MXF Media

Your facility may have a pipeline which creates processed or aligned MXF files using a dailies 
application. Avid recommends that the dailies system generate an AAF file of this media. The 
AAF can be imported into the Avid to generate bins with master clips that point to the MXF 
media. In the case of an AAF, the media will come online automatically. 

n If an AAF is not available, then you can use the Avid Media Tool to create clips from the MXF 
media.

Keeping media from the same source (at all available resolutions) in the same folder, will also 
ease the file maintenance and facilitate the reimport process in the event that a different 
resolution of a clip is required.

To link to MXF media via AAF:

1. Make sure that all your transcoded MXF files are located in the appropriate Avid MediaFiles 
folder (drive letter:\Avid MediaFiles\MXF\).

2. Open the bin in which you want to create the master clips.

3. Right-click in the bin, and select Import (or simply drag and drop your clips into the bin).

4. Locate the AAF file that you want to import and click Open.

If you imported an AAF, all clips in the bin will automatically be linked to the corresponding 
MXF media.

5. The master clips will appear in the bin.

To link to MXF media via the Media Tool:

1. Select Tools > Media tool.

2. Select the media drives where the MXF files are located.

3. Sort the clips by creation date and select the clips that you need.

4. Drag these clips into your bin.

5. The master clips will appear in the bin.

Merging Additional Metadata for Clips

You can import additional metadata for your media—such as information from a 3rd-party 
application that processed the media—and merge it with existing master clips in a bin. This 
metadata will be imported as long as it follows the Avid conventions for the bin column data. 
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To merge additional metadata into a bin:

1. Select the master clips for which you have additional metadata to merge.

2. Right-click on one of the clips, and select Import.

3. Locate the ALE file holding the metadata that you want to import, and click Open.

4. To select options for combining events on import, click Options to open the Import Settings 
dialog box. 

5. From the Shot Log tab, you must select Merge events with known master clips.

When this option is selected, your Avid editing application merges information in the shot 
log onto selected master clips based on the matching tape name or source file name. This 
must be an exact match and so should the START and END timecodes. 

6. Click OK to close the Import Settings dialog box and return to the Select Files to Import 
dialog box.

7. Select the source file from the list and click the Open button.

When your Avid editing application finishes importing the file, the clips (or new metadata 
for the clips) will appear in the selected bin.

Rendering Effects

Any effects applied to clips on the timeline will use the project color space (Rec 709) when they 
are processed for real-time playback. All effects-processing for playback is done on the fly, in 
some cases, dropping frames or slowing down as necessary to display your color-corrected 
output at high quality for evaluation purposes. Playback is not cached to RAM. You can choose 
to invoke the Render option and cache the new media to disk storage in order to play your 
sequence smoothly. Any precomputes rendered to the disk storage will also be generated using 
the project color space with a maximum bit depth of 10-bit. 

Setting the Mask Regions for the Final Output

You can specify mask margins on the output frame to create a master with a different aspect ratio 
than the project setting. This provides many useful features especially for those dealing with film 
distribution (e.g. widescreen mode for DVD).

You will be able to select from various aspect ratio presets. In the viewers, the selected aspect 
ratio will mask out (with a gray or black background) any area of the image that is not inside the 
specified rectangle. No render is needed during normal editing operations… For example, if you 
apply a dissolve or an effect, the mask is not processed. The viewer simply displays the masked 
area as shown in the illustration below.
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For final output, the mask margins will be applied, and rest of the output frame will be filled with 
black. The mask is rendered when exporting the sequence.

To set the mask margins for the project:

1. In the Project dialog box, select the Format tab.

2. Click the Mask Margins button.

The Target Settings dialog displays.

Project frame (HD)

Mask margins

Scene cropped to mask margins
and filled with black
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3. Select one of the mask presets or set the margins manually by selecting the appropriate 
percentage of the image to be occluded.

To display the mask area in the viewers:

1. Right-click in the source or record viewer and select Target Mask.

2. Choose from one of the following options:

The viewer updates accordingly.

Option Description

No Mask Does not display masked region.

Gray Mask Displays masked region with a translucent gray to allow 
you to view the full image.

Black Mask Blacks out the masked region to display the image as it 
would appear when output.
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Source viewer showing full image with gray mask

Record viewer showing reformatted image with black mask
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Exporting Sequences to File

The media formats for which you can output media include the following—QuickTime (MOV, 
AVI), Windows Media (WMV), MPEG, HDV, DV Stream, single-frame graphics (PNG, TIFF, 
BMP, etc.).

Before you output your sequence, refer to “Preparing to Export a Sequence” in the Help for your 
editing application. 

To select the section for export:

1. Render any AMA-linked clips and effects in your sequence.

2. Identify the portion of the sequence that you want to export.

n For information on setting options in the Export Settings dialog box, see the Help.

3. Select the clip or sequence by doing one of the following:

t Click the monitor that displays the clip or sequence you want to export.

t Click the clip or sequence in a bin. Ctrl+click (Windows) or Shift+click (Macintosh) to 
select multiple clips or sequences.

4. Do one of the following:

Option Description

To export specific 
tracks in a clip or 
sequence:

Enable the tracks in the Track Selector panel, and disable all others.

Ensure that Use Enabled Tracks is selected in the Export Settings 
dialog box.

To export a 
single-frame graphic:

Mark an IN point to export the marked frame from a bin or a monitor, 
or move the position indicator to the frame you want to export.

Ensure that Use Marks is selected and that Sequential Files is 
deselected in the Export Settings dialog box.

To export part of a 
clip or sequence:

Mark IN and OUT points to export the marked range from a bin or a 
monitor. If you mark an IN point and no OUT point, your Avid 
editing application exports from the IN point to the end of the clip or 
sequence.

Ensure that Use Marks is selected in the Export Settings dialog box.

To export the entire 
clip or sequence:

Make sure the topmost track is monitored.

Ensure that Use Enabled Tracks and Use Marks are deselected in the 
Export Settings dialog box.
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t Select File > Export.

t Right-click the clip or sequence, and then select Export.

The Export As dialog box opens with a default file name in the File name text box 
(Windows) or the Save As text box (Macintosh), based on the file type.

5. Click the Export Setting menu, and select one of the predetermined settings. 

This menu lists the possible formats in which you can export your selection. It also 
determines the type of file(s) that will be exported. For example, if you select Sorenson 
Squeeze, then a QuickTime reference file will be exported. 

Here are the possible options when exporting to media files:

n If none of these meet your needs, then select Untitled and click Options to create a customized 
export setting.

6. If you want to view or modify the current Export Setting, click Options.

Export Setting Export Format

Avid 3D Audio WAV

Avid Pro Tools LE (Mbox-Ref) MOV

Fast-Export QuickTime NTSC MOV

Fast-Export QuickTime PAL MOV

Macintosh Image NTSC TIF

Macintosh Image PAL TIF

Make New - QuickTime Reference MOV

Pro Tools QuickTime (ref) MOV

QuickTime Reference MOV

QuickTime Reference DV Codec MOV

Send to QT Movie MOV

Sorenson Squeeze MOV

Sorenson Squeeze - Encode for DVD MOV

Windows Image NTSC BMP

Windows Image PAL BMP
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The Export Settings dialog box opens. 

The export settings for some formats can be complicated. In some cases, options in the 
Export Settings dialog box open additional dialog boxes with further options. If you are 
modifying the Export settings, consult “Common Export Settings” in the Help.

Close the Export Settings dialog box to return to the Export As dialog box.

7. Select the destination folder for the file.

8. Enter a Filename for the selection that will be exported. 

The extension will depend on the Export Setting that you chose.

9. Click Save.

Your Avid editing application exports the file.

If you abort the Export while it is in progress, any files that were created, will be deleted.

Exporting Sequences to External Applications

If you need to apply custom effects or if you intend to finish your project on another application 
such as Avid DS for color grading, effects and other finishing, then you can export your sequence 
to a project data file. Your Avid editing application allows you to export part, or all your 
sequence to an AAF/AFE/EDL along with the associated video and audio media.
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To select the section for export:

1. Identify the portion that you want to export.

n For information on setting options in the Export Settings dialog box, see the Help.

2. Select the clip or sequence by doing one of the following:

t Click the monitor that displays the clip or sequence you want to export.

t Click the clip or sequence in a bin. Ctrl+click (Windows) or Shift+click (Macintosh) to 
select multiple clips or sequences.

3. Do one of the following:

t Select File > Export.

t Right-click the clip or sequence, and then select Export.

The Export As dialog box opens with a default file name in the File name text box 
(Windows) or the Save As text box (Macintosh), based on the file type.

4. Click the Export Setting menu, and select one of the predetermined settings. 

This menu lists the possible formats in which you can export your selection. It also 
determines the type of file(s) that will be exported. For example, if you select Export to Pro 
Tools, then an AAF metadata file will be exported. 

Here are the possible options:

Option Description

To export specific 
tracks in a clip or 
sequence:

Enable the tracks in the Track Selector panel, and disable all others.

Ensure that Use Enabled Tracks is selected in the Export Settings 
dialog box.

To export a 
single-frame graphic:

Mark an IN point to export the marked frame from a bin or a monitor, 
or move the position indicator to the frame you want to export.

Ensure that Use Marks is selected and that Sequential Files is 
deselected in the Export Settings dialog box.

To export part of a 
clip or sequence:

Mark IN and OUT points to export the marked range from a bin or a 
monitor. If you mark an IN point and no OUT point, your Avid 
editing application exports from the IN point to the end of the clip or 
sequence.

Ensure that Use Marks is selected in the Export Settings dialog box.

To export the entire 
clip or sequence:

Make sure the topmost track is monitored.

Ensure that Use Enabled Tracks and Use Marks are deselected in the 
Export Settings dialog box.
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n If none of these meet your needs, then select Untitled and click Options to create a customized 
export setting.

5. If you want to view or modify the current Export Setting, click Options.

The Export Settings dialog box opens. 

The export settings for some formats can be complicated. In some cases, options in the 
Export Settings dialog box open additional dialog boxes with further options. If you are 
modifying the Export settings, consult “Common Export Settings” in the Help.

Close the Export Settings dialog box to return to the Export As dialog box.

6. Select the destination folder for the file.

7. Enter a Filename for the selection that will be exported. 

The extension will depend on the Export Setting that you chose.

8. Click Save.

Your Avid editing application exports the file.

If you abort the Export while it is in progress, any files that were created, will be deleted.

Export Setting Export Format

AudioVision AAF

Avid 3D Video AAF

Avid Pro Tools LE (002) AAF

Avid Pro Tools LE (Mbox-AAF) AAF

Avid DS AFE

Consolidate Audio to Folder AAF

Consolidate-Embed Audio Only OMF

Consolidate-Link Audio and Video AAF

Export to Pro Tools AAF

Link to Audio Only AAF

Link to Audio and Video AAF

Link to Audio and Video Mixdown AAF



3 Acquisition of File-Based Media (AMA)

You can link, import, or export clips and sequences from many third-party volumes or third-party 
files to and from the Avid editing system. You can manipulate and edit this media as you would 
any other clip or sequence.

File-based media can be acquired from a third-party device (a camera, reader, or drive), from a 
CD or DVD, from a folder on your system, or from a virtual volume (a server connected to your 
system). To move the media into your Avid editing system, you have the option to use the AMA 
method (Avid Media Access) which links the file based media directly into a bin through an 
AMA plug-in, or you can use the non-AMA method which imports the media onto your system. 
When you work with high-resolution media, the AMA method is the preferred and the faster 
method.

AMA linking also allows for more metadata to be brought into the bin which gives you more 
information about the media. For example, essence marks (or markers) associated with the clip 
are automatically brought into your bin.

n For information on importing and exporting media, see “Importing Files” on page 393 and 
“Exporting Frames, Clips, or Sequences” on page 1145.

Before you begin working with AMA, make sure you have done the following:

• Go to avid.com/ama to make sure you download the latest plug-in for your specific 
third-party device.

• If you are using an XDCAM, XDCAM EX or a P2 device, make sure you have the 
appropriate drivers installed. See your third-party documentation for information on 
installing drivers.

• Connect the third-party device according to the documentation supplied with the device.

The Avid Media Access (AMA) Workflow

Avid Media Access (AMA) is a plug-in architecture that lets you link directly to clips on an 
external third-party device. The device can be a camera, a card reader, an optical disk, a virtual 
volume. AMA lets you be more productive by browsing and editing directly from the device or 
volume.

http://www.avid.com/US/products/Avid-Media-Access/Plug-ins
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There are two ways of browsing and editing this media:

• Manually browse through the media on the third-party device, and link to selected media to 
create master clips in your bin, or

• Move all the media from the third-party device to an Avid dynamic media folder where you 
have set up an automated process to create the master clips.

Typical media management functions (e.g. deletes, transcodes, consolidates) apply to all 
AMA-linked clips in the same robust manner as they do for managed MXF Avid-compliant 
OPAtom files. All media, whether captures, imported or linked by AMA, will be displayed in a 
single window in the Media Tool. 

AMA and dynamic media folders are the quickest method by which you can automate the 
acquisition of footage, and significantly enhance your production workflow when working with 
media in popular digital formats.

With the use of dynamic media folders, you can organize your files and assign automated actions 
to a “watched” folder system. These actions run in the background, allowing you to keep 
working while files are being ingested into the application. The actions include copy, consolidate 
and transcode—see “Creating Dynamic Media Folders” on page 71.

The illustration below shows how you can automate the acquisition of file-based media in the 
background so that you can continue editing your sequence without interruption.

Before you begin editing, set up media service profiles to run automated media acquisition 
actions on the specific drives/folders where the original media is located. Any files placed in 
these folders will be processed and managed in the background.
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1. You can begin the editorial by linking directly to the media on an external device. In the 
meantime, the pre-configured Dynamic Media Folder (DMF) profiles will automatically 
copy the files from the external device to an AMA media folder of your choice on a local or 
shared storage. These folders will be managed and indexed by the application. 

2. Master clips will be created for all the copied files and added to a 'staging' area so as not to 
cause interruptions each time a new file is acquired. Any related audio and video files will be 
auto-synced. Similarly, any related clips coming from multiple cameras will be 
auto-grouped.

3. Depending on how your dynamic media folders were configured, some specific file formats 
will be consolidated and/or transcoded to MXF proxy media. This media will be placed in 
the Avid MediaFiles folder and separate master clips (*.new) will be created in the bin for 
this media. 

2

Avid Media
Files folder

(MXF OP Atom
formats)

Perform manual 
relink of clips to 
transcoded media

Media consolidated
and/or transcoded

1

Request bin update,
and the clips point to 
source files that have 

been copied to the
AMA media folders

External
card reader

4

Dynamic
Media folder

(native formats)

Files moved
to local or

shared folder

Master clips
created

Background Process

New master clips created
for transcoded/consolicated media

Avid Media Composer

3

5

Set up automated
processes to move 
files to a local or 
shared folder
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4. When files are ready to be pulled into a bin, you will be notified by a green light to the right 
of the audio meters in the timeline. Through the Dynamic Media Folders dialog, you can 
request a bin update which will pull the clips into a bin. 

Any AMA-linked clips already on the timeline will automatically point to the new location 
of the media in the designated AMA media folder(s). Similarly, if any files were 
consolidated, and you selected the “relink” option in the DMF dialog, the master clips will 
automatically point to the new consolidated files.

5. If you want to work with transcoded media, on the other hand, you need to manually relink 
your sequence to the new master clips in the bin. 

n In an Interplay environment, the relink can be done automatically. See “Enabling Dynamic 
Relink” in the online help.

Considerations and Limitations for AMA

Footage from the Sony XAVC and ARRI ALEXA cameras can be recorded directly to MXF. 
Since Avid will have native HD codecs for these MXF formats, editors can link to or import this 
media in Media Composer. Working with the MXF media provides better performance for 
playback and rendering.

Other high resolution raw file formats that are not supported by Media Composer can be 
transcoded to MXF by Avid MetaFuze. 

The following limitations apply:

• When the AMA setting is activated, the non-AMA method does not appear in the File menu. 
Deactivate the AMA setting to display the File > Import P2 (and Import XDCAM Proxy) 
option. The AMA setting is on by default.

• Windows UNC (Universal Naming Convention) paths are supported with AMA media. You 
can move your AMA bins from a Windows system to a Macintosh system and from a 
Macintosh system to a Windows system. The media files need to reside in the same shared 
location when you move the bins to and from different operating systems.

• Do not AMA link to a volume or file if the file path name has an illegal character. AMA 
clips display offline if the file path name you are linking to contains illegal characters, 
including < > : “ / | ? *. for Windows and : for Macintosh.

• You can create stereo clips from AMA-linked media. Refer to Avid Stereoscopic 3D Editing 
Workflow Guide.

• Interplay and Interplay Sphere users can use the dynamic relink capability to view the best 
available media for AMA-linked clips. Refer to “Using Dynamic Relink with Interplay 
Sphere Editing Systems” on page 49 or the Avid Interplay Sphere Remote News Editing 
Workflow Guide.
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• When you render an audio effect on an AMA media clip, all audio media files are written as 
PCM (MXF), regardless of what you set for the audio file format.

• Avid does not support MultiCamera editing with AMA clips.

• You should not mix workflows. Either use the AMA method or use the traditional 
import/batch import method.

Viewing Installed AMA Plug-ins

Once you download and install a third-party plug-in from avid.com/ama, you can enter a console 
command to view a list and the version number of the plug-ins installed on your system.

To display the list of installed AMA plugins:

1. Select Tools > Console.

2. In the command entry text box, type: AMA_ListPlugins

3. Press Enter (Windows) or Return (Macintosh).

AMA_ListPlugins displays a list of the plugins installed on your system.

Selecting the AMA Settings

You can set options in the AMA Settings dialog box to turn AMA on or off (on by default), to 
automatically mount your volumes, to customize your bin, and to set audio channel linking 
options.

To set up AMA:

1. In the Project window, click the Settings tab.

2. Double-click AMA.

The AMA Settings dialog box appears.

http://www.avid.com/US/products/Avid-Media-Access/Plug-ins
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3. Click the Volume Mounting tab.

4. If you want the system to automatically scan drives (volumes) every time, select the option 
“When mounting previously mounted volumes, do not check for modifications to the 
volume.” This option is off by default. 

5. If you remount a volume, deselect the option “When mounting previously mounted volumes, 
do not check for modifications to the volume,” and the system checks the modification date 
of the device or drive against the last time the clips were linked. If the date is the same, the 
clips come back online. If the date is different, the system links the clips again, and links any 
new clips added to the volume. This option is off by default.

n If you restart your Avid editing application, the system automatically rescans the drives 
regardless of the options you’ve selected.

6. To customize your bin, click the Bins tab.

By default, the system links your clips into a new bin using the same name as your project 
name. If you want to change the bin name or want to use an already existing bin, you can 
make these changes in the Bins tab. 

For more information on Bins options, see “AMA Settings: Bins Tab” on page 46.

n Depending on your AMA Settings, every time you insert a card into a reader , the system creates 
a new bin whether the same card or device has been previously inserted or not.

7. To map source audio channels to multichannel or mono tracks in your clips, click the Link 
Options tab, and then click Edit.
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The Set Multichannel Audio dialog box opens. For information on setting multichannel 
audio options, see “Using XDCAM Multiple Resolution Clips with AMA” on page 90.

8. Click OK.

Copying File-Based Media to a FireWire or Network 
Drive

After you insert cards or a disk into your third-party device, you can copy the media to a 
FireWire drive or a network drive and then eject the card or disk. You might find it convenient to 
copy several cards or disks to other drives so you can reuse the cards or disks.

You can also create Dynamic Media Folders (DMF) to copy all files placed in the DMF to a 
specified location. See “Creating Dynamic Media Folders” on page 71.

n You can work with media on a card/disk or work with media on another drive, but you cannot 
work with media that is stored in both places simultaneously. To avoid the problem, eject the 
card or disk after you copy the media files to the other drive.

To copy the card or disk media to another drive:

1. On the local or shared system drive, set up a folder for each card or disk you want to copy. 

Avid recommends that you do not place the media folder at the top level of the drive.

2. Give each folder a unique name that identifies the card or disk.

The name does not have to be the same as the actual card or disk name.

3. Navigate to the actual card or disk and select the folder with the media.

4. Do one of the following: 

t Copy and paste the contents of the card or disk media folder to the system folder.

t Click the card or disk folder and drag it to the system folder.

5. Eject the card or disk.

Dragging and Dropping File-based Media Directly to 
a Bin

You can drag and drop file-based media directly to a bin.
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To drag and drop files directly into a bin:

1. Navigate to the folder that contains the file based media.

2. Select the files you want to drag to the bin.

3. Alt + drag (Windows) or Option + drag (Macintosh) the files to the bin.

The files appear in the bin as AMA linked files. These are also managed files and appear in 
the Media Tool.

Creating Dynamic Media Folders

Dynamic Media Folders (DMF) are user created folders that allow you to efficiently work with 
file-based media. DMF folders allow you to manage and process media even when the editing 
application is not running. For example, you can create a DMF folder where the media from a 
digital camera can be moved off the camera and placed in the DMF, allowing the production 
team to quickly take the camera back out in the field. A profile associated with that DMF folder 
can be setup to have these files AMA link into a particular bin. 

n AMA media is now managed. Therefore the AMA media will now appear in the Media Tool and 
can be checked into Interplay.

You can also create DMF folders that are setup to perform time consuming tasks such as 
copying, transcoding or consolidating. You can create a DMF folder that copies all files placed in 
the DMF to a specified location. You can also setup a DMF to transcode or consolidate any file 
that is placed in the folder to a specified resolution. These processes occur in the background.

The basic workflow for using DMF folders is the following. 

•  Create a folder. This folder can sit on your desktop or anywhere on your Avid editing 
system.

• Assign a profile to the folder. This profile is where you specify the actions you want 
performed on the files. Any time files are added to that folder, the actions you set in the 
profile for that folder will be applied to those files.

• An indicator on the Timeline will let you know when files have been added to a DMF folder. 
Access the DMF window and choose to place the files from the DMF folder into the 
appropriate bin.

To create a Dynamic Media Folder:

1. Select Tools > Dynamic Media Folders.

The Dynamic Media Folders window opens. 



Creating Dynamic Media Folders

72

2. Create a new folder by clicking the + icon in the Dynamic Media Folders window.

The Select Folder window opens.

3. Browse to the folder you want to designate as a Dynamic Media Folder.

4. Click Select Folder.

5. Click the Profile Editor button to create a profile that you want associated with the DMF 
folder.

The Profile Editor opens.

6. Click the Menu bars to open the default profile summary and default AMA Settings and 
Actions.
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7. Select AMA Settings options as described in the following table.

Setting Option Description

AMA Plugin Link Using Select which Plug-in you want 
the editing application to use 
when performing AMA links 
for the files added to the 
selected DMF folder. If you 
are linking to Volumes, Avid 
recommends you select the 
Autodetect AMA Plug-in.

Bins Use active bin When this option is selected, 
your Avid editing application 
uses the currently active bin to 
store clips linked using AMA.
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8. To add additional actions to be performed on files found in the DMF folder such as copy, 
transcode, consolidate or check into Interplay, click the Actions + to add an action. 

Create a new bin When this option is selected, 
your Avid editing application 
creates a new bin to store clips 
linked using AMA and 
controls the bin name. This is 
the default option.

• Default bin naming 
convention: uses the 
project name for the bin 
(bin name followed by a 
consecutive number).

• Volume name: the name or 
label of the volume (for 
example D:).

• Specify bin name: lets you 
enter a new bin name.

Link Multichannel Audio Select this option if you want 
to assign audio tracks to 
specific channels in your 
linked media, up to a 
maximum of 16 audio 
channels for the clips in your 
bins. This allows you to 
specify which source channels 
are treated as mono or 
multichannel audio tracks in 
your project, rather than 
having to modify the clips in 
your bin after you link to the 
AMA media.

Click Edit to open the Multiple 
Mixes dialog box, which 
allows you to map audio tracks 
to channels.

Audio Start-Time Option (for 
Broadcast Wave)

Select this option to set the 
audio Project Rate for 
Broadcast Wave files.

Setting Option Description
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9. Click the Menu button on a row to access the desired copying, consolidating and/or 
transcoding actions you want to be performed on the files. Choose from the following 
options: 

Action Option Description

Copy to Folder Copy to: Click the Set button to choose 
the location where you want 
the files copied to.

Auto Relink when complete Files are automatically 
relinked when the copy is 
completed.

Checkin to Interplay Checks in assets to Interplay. 
When you select this option, 
also select the “Auto Relink 
when complete” option.

Consolidate Skip media files already on the 
target drive

Select to bypass files if some 
related media files are already 
located on the target drive.

Relink selected clips to target 
drive before skipping

Select to ensure that all 
selected clips are linked to 
media on the target drive.

Convert Audio Sample Rate Select this option to convert 
the sample rate to 32 kHz, 
44.1kHz, or 48 kHz.

Convert Audio Bit Depth Select this option to convert 
the Bit Depth to 16 Bit or 24 
Bit.
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Convert Audio Format Select either OMF (WAVE), 
OMF(AIFF-C), or MXF 
(PCM) audio format.

Video Drive
Audio Drive

Select the applicable drives.

Transcode Transcode Video Resolution Select the applicable Project 
type, Color Space, Raster and 
Codec you want to transcode 
to.

Apply Reformatting option 
(compatibility mode)

Transcodes the media and 
applies any framing and 
reformatting options that have 
been set on the master clips.

Apply color transformations Transcodes the media with any 
color transformations (color 
space, LUTs, CDLs) that have 
been applied to the master 
clips.

If these options are not 
selected, then the reformatting 
options, framing, and color 
transformations are not applied 
when the media is transcoded. 
The information however, is 
still retained in the clip 
metadata, and will be used 
with the transcoded media 
when the clip is dropped on the 
Timeline.

Convert Audio Sample Rate Select this option to convert 
the sample rate to 32 kHz, 
44.1kHz, or 48 kHz.

Convert Audio Bit Depth Select this option to convert 
the Bit Depth to 16 Bit or 24 
Bit.

Convert Audio Format Select either OMF (WAVE), 
OMF(AIFF-C), or MXF 
(PCM) audio format.

Action Option Description
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10. You can also reorder the actions by priority by dragging one above or below the other.

11. Click Save to save the Profile.

12. Name the Profile and click OK.

13. Select Enable in the Dynamic Media Folders window to make sure that any files added to the 
Dynamic Media folder will have the actions set by the associated Profile.

n Once a Profile is associated with a folder, you cannot change that Profile. You can only assign 
one Profile per folder.

When files are placed in a Dynamic Media Folder, you will see a progress indicator in the 
Timeline. If the Show Dynamic Media Folders progress indicator is green, new clips are 
available. 

14. Right+click the Show Dynamic Media Folders progress indicator and select Dynamic Media 
Folders.

The Dynamic Media Folders window opens.

15. Click Acquire. 

The new assets will populate the editing application Bin according to the Bin setting you 
chose in the Profile Editor. Any clips that have been consolidated or transcoded will also 
populate the bin as .new files. If some clips are still in process, they will populate the bin as 
offline. You can monitor the background progress of these files by selecting 
Tools > Background Queue.

Video Drive
Audio Drive

Select the applicable drives.

Action Option Description
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Linking Media with AMA

The editing application will automatically link clips on a volume when you connect to your 
third-party device. You can also use the File > AMA Link option to manually link to a volume or 
file. 

AMA media is managed. AMA managed media means that the AMA media is tracked. The 
AMA media is associated with .pmr and .mdb files. Therefore the AMA media will appear in the 
Media Tool and can be checked into Interplay.

AMA linking lets you point to media on a device or point to the media directly on your system. 
The media physically resides on your system or it can reside on an external device. The media 
points to the most recent source. For example, if you link the clips to a virtual volume on your 
desktop, the drive column displays the desktop as the location where the clips are linked to. If 
you then insert a card into a reader with the same media, the clips point to the media on the card. 
If you remove the card, the clips point to the media on the card and the clips appear offline. The 
card being the most recent source. Once the card is reinserted, the clips in the bin appear online. 
See also, “Using Virtual Volumes” on page 86 and “Virtual Volumes and AMA Bins” on 
page 87.

n For optimum viewing and playing, Avid recommends a single clip length should not exceed more 
than 12 hours.

n The decompose option from the Clip menu is not available with AMA. You do not need to 
decompose clips when you use the AMA Link.

To automatically link clips from a third-party device:

1. Connect the drive, card reader or device to your computer as described in the third-party 
device documentation.

The system scans the device and links the clips into the default bin and with the default 
multichannel audio track formats (based on the AMA settings). A link icon appears next to 
the clip.

To change the default bin, bin name, or audio track format, from the Project window 
double-click AMA Settings and select options from the Bins and Link Options tabs. For 
more information, see “AMA Settings” on page 46 and “Using XDCAM Multiple 
Resolution Clips with AMA” on page 90.

To link clips from a virtual volume with AMA:

1. Select File > AMA Link.

The Open dialog box opens.
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2. Navigate to the folder that contains your file-based media.

For P2, navigate one level above the Contents folder. For XDCAM disks, navigate to one 
level above the Clip folder. For XDCAM EX, navigate to one level above the BPAV folder. 
For RED, navigate to the root directory of the RED card. For GFCAM, navigate to the root 
directory of the GFPAK. For QuickTime, navigate to the QuickTime folder that holds the 
QuickTime files.

Depending if you are using an existing bin or creating a new bin, the Bin Selection dialog 
box opens. 
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3. Select Bin Selection options. 

4. Click OK.

The clips appear in the bin or bins depending on the options you selected. A link icon 
appears next to the clips.

To link clips from a file with AMA:

1. Select File > AMA Link.

You can also right-click a bin and select AMA Link.

2. The Open dialog box opens.

3. Navigate to and select the files you want to link to. Ctrl+click or Shift+click to select 
multiple files.

4. From the Files of Type menu either select Autodetect AMA Plug-in or select the plug-in 
from the list. Audodetect will detect the appropriate plug-in from the list of installed 
plug-ins.

Option Description

Single Bin Based On Selected Folder Places all linked clips into one default bin.

Single Bin Named Lets you create a new bin and type in a new bin name. 
Places all linked clips into that bin.

Bin(s) Based on Current AMA 
Setting

Places the clips in the bin(s) you set up in the AMA 
Settings Bins tab.

Bin(s) Based on Subfolders Places the clips in bin(s) based on their subfolders.

Top Bin Window Places the clips in the active bin.
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5. Click Open.

The clips appear in the active bin with the default multichannel audio track formats (based 
on the AMA settings). A link icon appears next to the clips.

If the system cannot link a file, an error message displays informing you to open the Console 
window for more information about the file(s) in error.

If you move the clip from the original drive to another drive on your system, the clip displays 
as offline in your bin.

n If you move a source file from one location to another and then back to the original location, you 
might need to refresh the bin to redisplay the clip. Close and reopen the bin to refresh the bin.

Relinking to AMA-Linked QuickTime Files

After you link Quicktime files into your sequence, you have the option to make changes (in a 
third party applications, such as Adobe After Effects) to that file. If you change the filename or 
change the location of the file, the best way to link that clip back into your sequence is through 
the relink option. Relinking to an AMA file allows you to link to a different file. This process 
only works if the targeted file is compatible with the old file, for example the file has the same 
duration, edit rate or number of tracks.

This feature is helpful when you have a group of linked clips that were moved to a different 
folder or drive. You can relink the clips to the new location. You can also use this feature to 
toggle between different versions of a QuickTime movie, for example a low-resolution version of 
the movie is myMovie_DV.mov and the high-resolution version of the movie is 
myMovie_1to1.mov. You can relink to both of these versions, to see which clip works better in 
your sequence.

At this time, Relink to AMA File(s) is only available with AMA QuickTime files.

To relink to AMA file(s):

1. Select the file(s) you want to relink by doing one of the following:

t Click a single file

t Shift+click to select multiple adjacent files

t Ctrl+click (Windows) or Command+click (Macintosh) to select multiple nonadjacent 
files

2. Right-click and select Relink to AMA File(s).

The Select file(s) to relink AMA clip dialog box opens asking you to locate the new file(s).

3. Locate the folder where the files exist. 

4. Click OK. 
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The clips appear linked in the bin. If all the clips you wanted to relink to do not reside in the 
selected folder, you will receive a dialog indicating how many files were not relinked. Open 
the Console window to see the name of the file or files that were not relinked.

n If the new file is not compatible with the clip in the bin (it does not have the same duration, edit 
rate or number of tracks), the clip in the bin retains its original link.

Spanned Clips
Spanned clips are clips that extend from one card to another. Avid supports working with 
spanned clips with some third party devices such as P2, AVCHD, Canon, and XDCAM EX. 

The following illustration shows how clips can span multiple cards.

Example of spanned clips. The white rectangles represent P2 cards and the gray rectangles represent clips. The 
first and third clips span multiple cards.
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When you work with spanned clips, consider the following:

• If you remove a card that contains a spanned clip, for example Card 2 in the above example, 
and you try to play Clip 1, it plays until it reaches the portion of the clip that resides on 
Card 2. Media Offline appears until you reach the media on Card 3. Avid recommends that 
you do not place another card in the removed card’s place unless you remove all the cards 
that contain the spanned clip (Cards 1 and 3 in this example). 

• You can mix cards that contain spanned and unspanned master clips. However, if you eject a 
card which contains a chunk of a spanned clip and insert another card, the master clips in the 
newly inserted card are not visible in the Media Tool but the media files are visible. To work 
around this, remove all the cards which contain chunks of the spanned clip and choose 
File > Unmount followed by File > Mount All (non-AMA method). All the master clips are 
visible.

• P2 and XDCAM EX spanned media covers multiple drives, but the bin displays only one 
drive letter. The drive letter in the bin might be any of the drives, but is usually the highest 
lettered drive where the media exists.

• If necessary, copy all spanned clips to another drive to ensure a clip’s integrity before you 
swap out the cards.

AMA Linking with Ancillary Data

You can AMA link to an XDCAM or an MXF (SMPTE 436M) clip with ancillary data, the 
ancillary data appears in your bin. You can link to the ancillary data clip without an Avid 
input/output hardware, however, in order to view the ancillary data in a monitor, an Avid Nitris 
DX or Avid Mojo DX device is required.

For information about ancillary data and data tracks, see “Preserving HD Closed Captioning and 
Ancillary Data” on page 1234 and “Data Track Method” on page 1235.

AMA Linking with Multichannel Audio

You can use the AMA Settings dialog box to define the audio track formats for the audio 
channels in your linked media, up to a maximum of 16 audio channels for the clips in your bins. 
This allows you to specify which source channels are treated as mono or multichannel audio 
tracks in your project, rather than having to modify the clips in your bin after you link to the 
AMA media.

The mappings affect all media clips created when you link to your source media. If you want to 
use different mixes for different master clips or different projects, create a custom AMA Settings 
template for each separate type of mix and then create your linked master clips.
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Each stereo track requires two channels, but you can mix mono and stereo input channels for 
your linking operation as long as you do not exceed the maximum of 16 audio channels for each 
master clip.

To specify the multichannel audio mix for linked AMA clips:

1. In the Project window, click the Settings tab.

2. Double-click AMA.

The AMA Settings dialog box appears.

For information about the AMA Settings, see “AMA Settings” on page 46.

3. Click the Link Options tab.

The Link Options tab lists any multichannel audio mappings in the current AMA Settings 
template.

4. Click Edit. 

The Set Multichannel Audio dialog box opens.
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5. Click the format buttons to select one of the following audio track formats for each pair of 
source channels:

You must map source audio channels in mono or stereo pairs. For example, you cannot map 
A1 to a mono track and A2 and A3 to a stereo track. Instead, map A1 and A2 to mono tracks, 
and A3 and A4 to a stereo track. If the source media does not have an audio channel on A2, 
the Avid editing application ignores the channel.

6. Click OK to close the Set Multichannel Audio dialog box, and then click OK to close the 
AMA Settings dialog box.

The Track Formats column in the bin Text view displays the format for all multichannel 
audio tracks in a master clip.

To save a custom map of linked audio channels as a settings template:

1. Click the Settings tab in the Project window.

The Settings list appears.

2. Click AMA.

3. Select Edit > Duplicate.

A duplicate setting appears in the Settings list.

4. Name the setting by doing the following:

a. Click the custom name column.

b. Type a name.

Button Track Format

Mono

Stereo
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c. Press Enter (Windows) or Return (Macintosh).

n The custom name column is the center column in the Project window. When you move the pointer 
over the custom name column, the pointer changes from a pointing finger to a text insertion bar.

You can select this new setting whenever you link clips with AMA.

The AMA Plug-in Log File

The Avid system creates an AMA plug-in log file when you link clips. The log file records errors 
and information about the clips. If you experience any problems while you link clips or if you 
receive an error message, check the AMA log file to get more information about the error (for 
example: a corrupt file or a bad filename). You can view the log file from the following location 
on your system:

• (Windows) drive:\Program Files\Avid\Media Composer\Avid FatalError Reports. The name 
of the log file is AMALoggerMM_DD_YY.log.

• (Macintosh) Volume/Users/Shared/AvidMediaComposer/Avid FatalError Reports. The 
name of the log file is AMALoggerMM_DD_YY.log.

Using Virtual Volumes
You can use a virtual volume to copy media from a card or disk. This lets you use the card or disk 
again. A virtual volume can be a folder on your desktop or a folder located on a server. However, 
the virtual volume folder should reside one level down from the root level in order for the system 
to display it as a virtual volume. The following are examples of virtual volumes:

• C:\Desktop\BPAV

• Z:\P2\Card 1

• Z:\GFPAK\

When linking to AMA volumes, the system looks into folders up to two levels deeper. This is 
helpful when linking to AMA volumes that contain left and right stereoscopic files/folders.

With the AMA method, all drives and virtual volumes associated with your bin mount 
automatically. You cannot remove a volume while in AMA, however you can remove a virtual 
volume.

To unmount a virtual volume:

1. Choose File > Unmount.

The Unmount dialog box opens.
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2. Select the virtual volume you want to remove.

3. Click OK.

The system removes the virtual volume from your system and clips linked to this virtual 
volume appear offline. When you restart your Avid editing application, the system scans the 
system for virtual volumes and the clips appear online.

Virtual Volumes and AMA Bins
If you select Volume Name in the AMA Bin Settings tab, the system names the bin the same 
name as the virtual volume drive name. If you continue to use the same virtual volume to link 
other media through AMA, the system continues to place the linked media in the same bin. If 
you want to create a new bin for different types of media you link through AMA, you can either 
create a new virtual volume drive for each type of media (XDCAM, XDCAM EX, P2, GFCAM, 
etc.) or you can create a new bin every time you link to new media on a virtual volume.

To create a new bin on the same virtual volume:

1. Before you link your media through AMA, click the Settings tab in the Project window.

2. Double-click AMA. 

3. Click the Bins tab.

4. Select “Create a new bin” and specify a new bin name. 

5. Click OK.

6. Select File > AMA Link.

The media appears in the newly created bin. Repeat these steps for each type of media.

Deleting Clips
You can delete master clips, but you cannot delete media files that reside on drives. Your Avid 
editing application treats files as read-only devices.

You can delete master clips and media files the same way you delete other master clips and 
media files. However, you might not be able to delete files that you moved rather than copied. If 
you cannot delete master clips and media files, first unlock the clips as described in the second 
procedure, and then delete them.

To delete files from cards/volumes:

1. Quit your Avid editing application.

2. On the desktop, navigate to the drive. 
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3. Select the files you want to delete and press the Delete key.

To delete files on a local drive in your Avid editing application:

1. In a bin, select the clips you want to delete.

2. (Option) Right-click and select Unlock Bin Selection.

3. Press the Delete key.

The Delete dialog box opens.

4. Select Delete master clips and Delete associated media files.

5. Click OK.

You can also choose to AMA Link if you want to open the assets as Read-only in a classic 
bin.

Using AMA Plug-Ins

The following topics include high-level procedures of a typical workflow you might use when 
you edit with a particular media type and AMA Plug-Ins.

Using XDCAM and XDCAM EX and XDCAM SR AMA Plug-Ins

The Sony® XDCAM™ decks and camcorders use an optical disk to store recorded media. The 
XDCAM devices record media in high-resolution MPEG IMX™, DVCAM™, and XDCAM HD 
formats or corresponding low-resolution or compressed (proxy) media (MPEG-4). This lets you 
work with the compressed or low-resolution media in an off-line editing session and then later 
conform or link the compressed media to the corresponding high-resolution media. The 
HDCAM SR AMA plug-in supports MXF-wrapped SR Lite and SR SQ formats (422 YUV and 
444 RGB) as transferred from HDCAM SR devices.

You can play XDCAM HD media to a Client monitor or output a digital cut as Best Performance 
(yellow/yellow) or Draft Quality (yellow/green). If you use Avid Nitris DX or Avid Mojo DX, 
you can play out the back of the HD-SDI.

The following steps describe a typical workflow for editing XDCAM, XDCAM EX or XDCAM 
SR clips with AMA.

n Do not mix AMA and traditional workflows. Either use AMA when you work with an XDCAM 
device or use the traditional import/batch import workflow.
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You should be aware of the following: 

• Playback performance from an optical disk is very slow. To create a sequence with multiple 
effects or layered tracks, Avid suggests that you consolidate the media to a local drive, 
instead of working directly from the optical disk.

• Avid has turned off redrawing of waveforms in the Timeline when you link to XDCAM clips 
that reside on a disk. This allows for a faster linking process. When the media is 
consolidated, the waveforms redraw.

• When you link XDCAM clips from an optical disk, Avid recommends that you do not 
display the bin in Frame view or Script view due to performance issues.

A typical workflow is as follows:

1. Make sure the Sony XDCAM and XDCAM EX, or XDCAM SR AMA plug-in is installed 
on your system.

2. For XDCAM, install the appropriate Sony XDCAM drivers.

You do not need drivers for XDCAM EX.

3. Insert the XDCAM disk or XDCAM EX card.

The system links the XDCAM clips into a bin. The media itself remains on the disk. The 
clips point directly to the high-resolution media on the disk. 

For XDCAM clips from an optical disk, a progress bar appears to show you how much time 
is left to link the media.

n If you use multiple cards and you remove one of the cards, your media displays offline.

4. Use the master clips to edit the sequence.

5. (Option) Rename the clips to help organize your material.

6. You can either transfer your media to your hard drive and then transcode or consolidate your 
sequence or clips, or consolidate directly from the XDCAM disk.

n When you consolidate, if you want to keep your AMA clips linked to the original source, select 
the option “Keep Master clips linked to media on the original drive,” in the Copying Media Files 
dialog box.

Consolidating your media helps when you work with multiple cards. If you remove a card 
from the reader, consolidating lets you view your sequence with all the media online. 

Due to the design of the Nitris input/output hardware, playback of XDCAM or XDCAM EX 
media on an Avid Symphony using Nitris causes dropped frames. To allow for full 
performance playback, transcode the XDCAM media into DNxHD media to play the video 
on your Avid Symphony system with Avid Nitris input/output hardware. 
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n  For information on consolidating your sequence, see “Consolidating Media” on page 567. For 
information on transcoding your sequence, see “Using the Transcode Command” on page 573.

7. Remove the XDCAM disk or XDCAM EX card:

t (Windows) Select Safely Remove Hardware icon in the taskbar and select Safely 
Remove XDCAM EX device name.

t (Macintosh) Click the device icon on your desktop and drag it to the Trash.

Using XDCAM Multiple Resolution Clips with AMA

The XDCAM AMA plug-in allows you to link to low-resolution (proxy) or high-resolution 
audio or video media. The AMA multiple resolution feature supports specific XDCAM devices 
which include a /PROAV folder. For example, the Sony PDWU1 Professional Disc Drive Unit. 
See your Sony documentation for information on how to enable the /PROAV directory for your 
device.

Avid editing systems do not support XDCAM proxy audio.

The following steps describe a typical workflow for editing XDCAM multiple resolution clips 
with AMA.

n Do not mix AMA and traditional workflows. Either use AMA when you work with an XDCAM 
device or use the traditional import/batch import workflow.

You should be aware of the following: 

• Playback performance from an optical disk is very slow. To create a sequence with multiple 
effects or layered tracks, Avid suggests that you consolidate the media to a local drive, 
instead of working directly from the optical disk.

• Avid has turned off redrawing of waveforms in the Timeline when you link to XDCAM clips 
that reside on a disk. This allows for a faster linking process. When the media is 
consolidated, the waveforms redraw.

• When you link XDCAM clips from an optical disk, Avid recommends that you do not 
display the bin in Frame view or Script view due to performance issues.

A typical workflow is as follows:

1. Use Sony’s PDZ-1 software to associate your low-resolution clips with metadata to identify 
the clip in the Avid bin. This includes entering a User Disc ID in the Disc Properties 
window.

2. The Sony XDCAM and XDCAM EX AMA plug-in should be installed on your system.

3. Install the appropriate Sony XDCAM drivers.

4. In the Project window, click the Settings tab.
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5. Double-click AMA.

The AMA Settings dialog box appears.

6. Click the Quality tab.

7. Click the appropriate resolution for your video and audio in the AMA Link Preference 
section, and click OK.

8. Insert the XDCAM disk in the XDCAM device.

9. Select Bin Selection options from the Bins tab.

For information on bin selection options, see “Linking Media with AMA” on page 78.

10. Select File > Link to AMA Volume.

The Browse for Folder dialog box opens.

11. Navigate to the XDCAM clips, and then click OK. 

The clips appear in the bin or bins depending on the bin options you selected. A link icon 
appears next to the clips.

12. Edit the sequence.

13. Right-click the bin and select Modify AMA Resolutions to relink your low-resolution to 
high-resolution media.

14. To consolidate your media, see “Consolidating Multiple Resolution Media” on page 92.

n When you consolidate, if you want to keep your AMA clips linked to the original source, select 
the option “Keep Master clips linked to media on the original drive,” in the Copying Media Files 
dialog box. 

15. Click the Highest Quality for your video and audio and click OK.

The highest quality clips appear in the bin along with the low resolution (most compressed) 
clips. A link icon appears next to the clips. 

If the system cannot find the corresponding low-resolution clip, it might be because you 
inserted the wrong XDCAM disk. If you insert the wrong disk, the system displays a 
message that informs you to insert the correct disk. If you used Sony’s PDZ-1 software and 
provided a disk name in the User Disc ID field, the system message displays the disk label 
name. If you did not use the PDZ-1 software, the system asks you to insert the disk 
containing the (low-resolution) clip selected in the bin.

16. Remove the XDCAM disk.

Spanned clips are clips that extend from one card to another. Avid supports working with 
spanned XDCAM EX clips in your Avid editing application. 

For more information about spanned clips, see “Spanned Clips” on page 82.
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Switching Between Multiple Resolution Media

Once you link to the low-resolution or high-resolution media and complete your edits, you can 
easily switch from low to high and high to low-resolution media. When you switch to a different 
resolution, the system replaces the clip in the bin with the new clip and resolution.

The steps below highlight switching from low-resolution to high-resolution media. You can also 
switch from high-resolution to low-resolution.

n For XDCAM, if you use the Sony PDZ-1 software to assign a User Disc ID, the Avid editing 
system displays this information in a bin column and knows what disk name is associated with 
each clip.

To switch from low-resolution to high-resolution media:

1. Insert the disk in the device.

2. Select the low-resolution clips in the bin.

3. Right-click the bin and select Modify AMA Resolutions.

The AMA Resolutions Quality dialog box appears.

4. Click the Highest Quality for your video (audio is always set to Highest Quality) and click 
OK.

The highest quality clips replace the most compressed (low-resolution) clips in the bin. A 
link icon appears next to the clips. 

If the bin contains clips from multiple volumes, you will be prompted to insert another disk.

Consolidating Multiple Resolution Media

When you are ready to move your media to shared storage, you can link to your resolution and 
consolidate at the same time.
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The steps below highlight consolidating high-resolution media. You can also consolidate 
low-resolution media.

For information on why you should consolidate, see “Consolidating Media” on page 567.

To consolidate high-resolution media:

1. In the Project window, click the Settings tab.

2. Double-click AMA.

The AMA Settings dialog box appears.

For information about the AMA Settings, see “AMA Settings” on page 46.

3. Click the Quality tab.

4. Click the appropriate resolution for your video in the Consolidate Preference section, and 
click OK. 

If a particular resolution is not available, it will be grayed out.

5. To consolidate the clip, follow the steps in “Using the Consolidate Command” on page 569.

The resolutions you select in the Consolidate Preference area of the AMA Settings Quality 
tab displays in the Transcode/Consolidate dialog box when you consolidate or transcode.



Using AMA Plug-Ins

94

Using the P2 AMA Plug-In

Panasonic’s P2 equipment records DV, DVCPRO, and DVCPRO 50 media on compact, 
solid-state memory cards (P2 cards). Avid editing applications support editing of media directly 
from these memory cards, without the need to capture. You can also write your sequence back to 
the P2 card. Panasonic P2 video and audio media is recorded in MXF format.

The following are recognized as P2 cards by your Avid editing application:

• Panasonic P2 cards in an attached reader or camera or in a laptop PC Card slot.

• Synthetic P2 cards. A complete copy of a P2 card copied to the root of a drive or mounted as 
a drive, for example, by mapping to a drive letter.

Each P2 card stores MXF files in two folders:

• (Windows) drive:\Contents\Audio 

(Macintosh) Macintosh HD/Contents/Audio

• (Windows) drive:\Contents\Video

(Macintosh) Macintosh HD/Contents/Video

Examples of MXF audio and video files contained in the Audio and Video folders. Top: four audio tracks for a single 
clip. Bottom: the corresponding video track.
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Panasonic P2 devices write individual MXF audio and video media files for each track of each 
clip. For example, a P2 clip that includes one track of video and four tracks of audio is stored on 
the P2 card as five individual media files. Within your Avid editing application the five media 
files are represented as a single clip with audio and video.

The following steps describe a typical workflow for editing P2 clips with AMA.

n Do not mix AMA and traditional workflows. Either use AMA when you work with a P2 device or 
use the traditional import/batch import workflow.

A typical workflow is as follows:

1. Make sure the Panasonic P2 AMA plug-in is installed on your system.

2. Install the appropriate Panasonic P2 driver.

3. Mount one or more P2 cards (up to five). For information on mounting and naming P2 cards, 
see your Panasonic device documentation.

The system links the P2 clips automatically into a bin.

n If you use multiple P2 cards and you remove one of the cards, your media displays offline.

4. Use the master clips to edit and output a sequence.

5. (Option) Rename the clips to organize your material.

6. Consolidate or transcode your sequence or clips.

The media consolidates to the destination you set in the Media Creation dialog box.

Consolidating your media helps when you work with multiple P2 cards. If a card is removed 
from the reader, consolidating lets you view your sequence with all the media online. 

n When you consolidate, if you want to keep your AMA clips linked to the original source, select 
the option “Keep Master clips linked to media on the original drive,” in the Copying Media Files 
dialog box. 

n When you transcode a sequence, the system automatically defaults to convert both audio and 
video. You cannot transcode video only with P2.

n  For information on consolidating your sequence, see “Consolidating Media” on page 567. For 
information on transcoding your sequence, see “Using the Transcode Command” on page 573.

7. Remove the P2 card.
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If you work in an Avid shared storage environment, you can share sequences that contain P2 
clips in an Avid shared storage workspace. However, you can share P2 clips only if you 
transcode or consolidate them to a workspace.

• In an MXF workgroup, you can either consolidate or transcode P2 clips to a workspace. If 
you transcode, you must transcode P2 MXF files to another MXF resolution.

• In an OMF workgroup, you must transcode P2 clips to a workspace. You must transcode P2 
MXF files to OMF files.

If you consolidate or transcode clips to an Avid shared storage workspace, it automatically 
checks all related metadata into the asset manager. This makes the clips accessible to other users.

For more information on workgroup support, see the Avid Interplay Help.

n Some card slots of the P2 drive might require drive letters that have already been assigned to 
existing network drives. If your computer does not display all five card slots as drives, reassign 
the network drives or restart your system.

Spanned clips are clips that extend from one card to another. Avid supports working with 
spanned P2 clips in your Avid editing application. 

For more information about spanned clips, see “Spanned Clips” on page 82.

Using the AVCHD AMA Plug-In

AVCHD is a file-based format and does not use magnetic tape. Instead, video can be recorded 
onto DVD discs, hard disk drives, non-removable solid-state memory and removable flash 
memory cards.

n Play performance might vary depending on the type of medium you use and the speed of our 
computer. 

AVCHD media files are recorded in MTS format; the file contains both the video and audio. 
Audio can be either uncompressed PCM or Dolby® AC-3 format. 

n You must activate the Dolby AC-3 codec the first time you AMA link to an AVCHD clip. If you are 
connected to the Internet, activation is automatic. If you are not connected to the Internet, the 
system opens a dialog box and then the Avid License Control tool. Follow the on screen 
instructions to activate this feature.

The folder and file structure is dependent on the camera you use.

n Most AVCHD cameras produce default file names starting with “00000.” Be aware that you 
could have multiple clips with the same file name across multiple media drives.
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The following steps describe a typical workflow for editing AVCHD clips with AMA.

A typical workflow is as follows:

1. Install the AVCHD AMA plug-in on your system.

2. To link to an entire volume, attach the camera and insert a card, disc or drive. 

The system links the AVCHD clips automatically into a bin.

n It is highly recommended for performance reasons, that you copy the entire media volume to an 
external HD drive if you plan on copying media from a card. You may have to use the File > 
AMA Link command if the files do not automatically link.

n If you use multiple AVCHD cards and you remove one of the cards, your media displays offline.

3. To link to an individual AVCHD file, with the camera and card, disc or drive inserted, select 
File > AMA Link. 

The Open dialog box opens.

4. From the AMA Plugin Filter menu, select AVCHD.

5. Locate and select the .mts file(s) you want to link. Ctrl+click or Shift+click to select multiple 
files.

6. Click Open.

The clips appear in the active bin. A link icon appears next to the clips. 

7. Use the master clips to edit and output a sequence.

8. (Option) Rename the clips to organize your material.

9. Transcode your sequence or clips.

n When you transcode a sequence, the system automatically defaults to convert both audio and 
video. You cannot transcode video only with AVCHD.

n  For information on transcoding your sequence, see “Using the Transcode Command” on 
page 573.

Spanned clips are clips that extend from one card, disc or drive to another. Avid supports 
working with spanned AVCHD clips in your Avid editing application. 

For more information about spanned clips, see “Spanned Clips” on page 82.
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Using the Canon XF AMA Plug-In

The Canon XF305 and Canon XF300 camera records MPEG-2 media onto compact flash cards. 
Through the Canon XF AMA plug-in and the MXF AMA plug-in, you can link to Canon 
MPEG-2 media through the AMA method. Canon XF video and audio media files record in 
MXF format.

You can edit directly from a flash card, without having to capture. You can link to a Canon XF 
flash card and reader attached to your system or copy a Canon XF flash card to the root of a 
drive. 

Each card stores the video and audio files in:

• (Windows) drive:\CONTENTS\CLIPS

• (Macintosh) Macintosh HD/CONTENTS/CLIPS

n AMA does not recognize clips if the folder names in the selected path contain double-byte 
characters (DBCS). AMA recognizes folders with the directory path that includes ASCII 
alphanumeric characters.

A typical workflow is as follows:

1. The Canon XF AMA plug-in and the MXF AMA plug-in should be installed on your 
system.

2. Mount the flash cards.

The system links the Canon XF clips automatically into a bin.

n If you use multiple flash cards and you remove one of the cards, your media displays offline.

3. Use the master clips to edit and output a sequence.

4. (Option) Rename the clips to organize your material.

5. Consolidate or transcode your sequence or clips.

The media consolidates to the destination you set in the Media Creation dialog box.

Consolidating your media helps when you work with multiple cards. If a card is removed 
from the reader, consolidating lets you view your sequence with all the media online. 

n When you consolidate, if you want to keep your AMA clips linked to the original source, select 
the option “Keep Master clips linked to media on the original drive,” in the Copying Media Files 
dialog box. 

n  For information on consolidating your sequence, see “Consolidating Media” on page 567. For 
information on transcoding your sequence, see “Using the Transcode Command” on page 573.

6. Remove the flash card.
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Spanned clips are clips that extend from one card to another. Avid supports working with 
spanned Canon XF clips in your Avid editing application. For more information about spanned 
clips, see “Spanned Clips” on page 82.

Using the GFCAM AMA Plug-In

The Ikegami GFCAM HDS-V10 is a tapeless camera/recorder that uses flash memory instead of 
video tapes as a recording medium. GFCAM devices record MPEG-2 Long GOPmedia onto a 
GFPAK™, a removable high-speed storage medium. GFCAM is only available through the AMA 
method. GFCAM video and audio media files record in MXF format.

Each GFPAK stores the video MXF files in:

• (Windows) drive:\BINxxx\VIDEO

• (Macintosh) Macintosh HD/BINxxx/VIDEO

Each GFPAK stores the audio MXF files in:

• (Windows) drive:\BINxxx\AUDIO

• (Macintosh) Macintosh HD/BINxxx/AUDIO

The GFCAM video file directory stores MXF files regulated by SMPTE 390M (MXF OP-Atom) 
and SMPTE 381M (MXF mapping MPEG streams into MXF GC). If a video clip needs to split, 
such as under the FAT32 file system, the system creates multiple MXF files for that clip.

The GFCAM audio file directory stores MXF files regulated by SMPTE 382 (MXF mapping 
AES3 and BWF into the MXF GC). Each file has an AES channel that consists of two audio 
channels. For example, the system creates two MXF files from two AES channels (four audio 
channels). If an audio clip splits, the system creates multiple audio files for that clip.

GFCAM allows gapless recording over several GFPAKs, however, each GFPAK handles the 
contents as a separate clip. If you record across three GFPAKs, you create three separate clips. 
You can then edit those clips together into one continuous sequence. 

n 1080p/23.98 pulldown and 720p/23.98 pulldown record at 59.94fps and are only compatible 
with 1080i/59.94 and 720p/59.94 projects.

1080p/29.97 records as PSF at 59.94fps and is only compatible with 1080i/59.94 projects.

1080p/25 and 720p/25 record as PSF at 50fps and are only compatible with 1080i/50 and 
720p/50 projects.
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A typical workflow is as follows:

1. Make sure the GFCAM AMA plug-in is installed on your system.

2. Insert the GFPAK.

Your Avid editing system links the GFCAM clips automatically into a bin. The media itself 
remains on the disk. The clips point directly to the high-resolution media on the disk. 

n If you use multiple GFPAKs and you remove one of the GFPAKs, your media displays offline.

3. Use the master clips to edit the sequence.

4. (Option) Rename the clips to organize your material.

5. Consolidate or transcode your sequence or clips.

Consolidating your media helps when you work with multiple GFPAKs. If a GFPAK is 
unplugged, consolidating lets you view your sequence with all the media online. 

n When you consolidate, if you want to keep your AMA clips linked to the original source, select 
the option “Keep Master clips linked to media on the original drive,” in the Copying Media Files 
dialog box. 

n When you transcode a sequence, the system automatically defaults to convert both audio and 
video. You cannot transcode video only with GFCAM. 

6. Disconnect the GFPAK.

Working with Shot Marks and Check Marks with GFCAM Media

GFCAM products use Shot Marks and Check Marks to store metadata about media clips. 

Shot Marks allow GFCAM cameras to mark events such as clip start points or audio clipping. 
Press the RET button on the GFCAM device while you record or playback to set a Shot Mark. 
For a description of Shot Marks, see your GFCAM documentation.

In the AMA method, Shot Marks are brought over automatically and appear as markers in your 
Avid editing application. There is no text associated with a Shot Mark, just a marked location (or 
a marker). For information about editing markers, see “Using Markers” on page 646.

A Check Mark flags a “good shot.” The AMA method translates this good shot clip with the 
word “true” in a new bin column named Check Mark. If there are no Check Marks associated 
with a clip, a Check Mark heading does not appear.
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Using the RED AMA Plug-In

The RED ONE camera generates a 4K (or 2K - 4.5K) full resolution REDCODE™ RAW (.R3D) 
file. Media is stored on a REDFlash card or a RED drive. You can link to a specific R3D file on 
the volume or link to the entire volume. RED ONE cameras record metadata which displays in 
an Avid bin. The metadata includes: edge code, timecode, lens parameters, audio settings and 
any video image processing information.

Your Avid editing application supports RED R3D files as high quality HD media. Once you link 
the clips through AMA, you can change and fine-tune the clip color settings through the Source 
Settings dialog. 

n You cannot consolidate the RED media in your Avid editing application.

The RED Camera records a unique clip name and additional files that include the REDCODE 
RAW files and an optional QuickTime reference file placed in a clip folder (.RDC). The system 
names clips by Camera Letter + Reel Number + Month + Day + a two digit alphanumeric 
random number.

For example: A001_C002_0502A6.RDC

Each clip folder (.RMD) is at the root directory. In each of these folders is the .RDC folder which 
contains the video, audio, and metadata files:

• (Windows) drive:\camera+reel_date.RMD\camera+reel_clip_date+random number.RDC

• (Macintosh) Macintosh HD/camera+reel_date.RMD/camera+reel_clip_date+random 
number.RDC

Avid's RED workflow allows you to work with RSX, RLX, and RMD files to manage a clip's 
color. You have access to all the metadata and color values in the raw RED files as well as the 
above mentioned “look” files associated with this media. You may also make non-destructive, 
custom color adjustments to the R3D clip. These adjustments can be made at any stage of the 
process. 

AMA detects folders named with RMD and RDC and files named .R3D.

n Audio is included in the RED files, and will display as .wav files in the bin.

You cannot span media across multiple cards. Each clip is recorded as a separate clip, regardless 
of how many cards you use. There is a 2GB limit on a single master clip. As you record footage, 
once a 2GB file is captured, an R3D file is created (.001). The camera continues to record and 
the next 2GB (or less) of media creates another R3D file (.002) until you end recording. So, you 
can have several R3D files in one clip folder but they are all associated with one master clip. 
When you link these files/folders through the AMA method, one master clip appears in your bin
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A typical workflow is as follows:

1. Make sure the RED AMA plug-in is installed on your system.

2. Attach the RED drive or insert a REDFlash card.

Your Avid editing system links the RED clips automatically into a bin. The media itself 
remains on the disk. The clips point directly to the high-resolution media on the disk. All 
metadata information displays as columns in the bin.

n If you use multiple cards and you remove one of the cards, your media displays offline.

3. Right-clip the clip in the bin and select Source Settings.

For detailed information to set clip parameters, see “Adjusting RED Source Settings” on 
page 103.

4. Use the master clips to edit the sequence.

5. (Option) Rename the clips to help you organize your material.

6. Choose the video quality from the Transcode & Consolidate tab of the Media Creation 
setting.

For more information, see “Preparing your RED Clip for Transcode, Mixdown, or Render” 
on page 102.

7. Transcode your sequence or clips to an HD or SD resolution.

If you need to output to a resolution higher than HD, then export an AFE of your sequence 
for the conform process on an Avid DS. If your high-resolution media is on a shared storage 
device and Avid DS has access to the device, Avid DS automatically relinks to the RED 
files.

8. Remove the RED drive or card.

For information on preparing your RED clip for transcode, mixdown, or renders, see “Preparing 
your RED Clip for Transcode, Mixdown, or Render” on page 102

Preparing your RED Clip for Transcode, Mixdown, or Render

If you want to take a RED clip and offline it to another application, you can create a different 
resolution RED file, depending on your requirements. This changes the speed and quality of the 
clip, which could affect the playback performance. The higher the video quality the slower the 
process (transcode, mixdown, render). The lower the video quality the faster the process. Before 
you transcode, mixdown or render your clip or sequence, set the appropriate quality in the Media 
Creation dialog box. 

n If you apply any Reformat options (stretch, letterbox, etc.) to your clip, when you perform a 
transcode, the reformatting options will apply.
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To prepare your RED clip for transcoding, mixdown or rendering:

1. Before you transcode, mixdown or render, select Tools > Media Creation.

2. Click the Mixdown & Transcode tab or click the Render tab.

3. Select the playback quality from the R3D Source Quality (Debayer) menu. 

t Full 

t Half (Best Quality) 

t Half (Good Quality)

t Quarter

t Eighth 

t Sixteenth

4. Click OK.

5. Transcode, mixdown or render your clip or sequence as required.

Adjusting RED Source Settings

When you link to R3D (RED) files, the Avid editing system reads each REDCODE RAW file 
directly. You can then change the clip’s color values: color balance, exposure, and contrast in the 
Source Settings window. This color value information is encoded with the R3D file through an 
RLX, RSX or RMD file. These files hold the camera’s original color values of your clip. 

n The RLX, RSX or RMD files might be created if you set the color values outside of the Avid 
editing application. These files can be loaded and applied to the associated RED clip through the 
Source Settings window.

When a RED clip displays in the bin, the system displays the metadata columns of the clip’s 
color values. For example: Color Space, Gamma Space, Kelvin, Tint. You can export this 
information to ALE (Avid Log Exchange) and XML (through Avid FilmScribe) for downstream 
use in your workflow.

The AMA Source Settings window also has various color spaces to choose from. You can set up 
different color options (or presets) in each of these color spaces and then apply their color values 
to multiple clips.

To change the RED source settings:

1. Link the RED clip through the AMA Link option.

2. Right-click the RED clip in the bin and select Set Source Settings.

The Source Settings dialog box opens. The clip displays in the video area.
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You can choose from the Settings menu to select a camera metadata setting or an RSX, RLX 
or RMD setting (template), or adjust your own custom parameters. This procedure details 
the custom parameters.

3. Drag the video slider to the frame you want to view.

The new frame displays and the histogram updates.

The histogram is a tool that helps you more precisely adjust Source Settings. For more 
information about the histogram, see “Understanding the Source Settings Histogram” in the 
Avid editing Help.
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4. Set the appropriate options, you can select from a menu, drag the sliders, enter values or 
click the eyedropper:

Option Description

Color Space Choose from:
Camera RGB: as close to RAW
REC.709: SMPTE standard color space for HD
REDcolor (default): newest, more accurate color science from RED
REDcolor2: better skin tones and color from RED
REDcolor3: more improvements from RED
REDSpace: based on the camera’s RGB but more saturated

Gamma Curve Lets you override the gamma curve. Choose from:
REC.709: a REC.709 gamma curve with a linear portion at black and 
a gamma at 2.2 curve
REDLog: maps the 12-bit sensor data on to a 10-bit curve with 
minimal loss
REDLogFilm: a way of containing a large dynamic range in a video 
file. Needs to be viewed through a LUT to convert it for viewing on a 
monitor.
REDSpace: based on REC.709 but with more contrast
REDGamma (default): gamma curve from RED with a smoother 
highlight rolloff
REDGamma2
REDGamma3

White Balance Adjusts the color temperature of your image in one click. Use the 
eyedropper icon and then click a known white area in your RED 
footage to achieve the correct light or neutral balance. This option is 
equivalent to adjusting the Kelvin and Tint options. When you use 
the White Balance option, the system automatically adjusts Kelvin 
and Tint. It is recommended you adjust White Balance first before 
performing any other adjustments to the image for best quality. This 
change adjusts the entire clip and updates the histogram.

Kelvin Adjusts the RGB color to compensate for red - blue tinting of the 
scene at different color temperatures of the ambient light while you 
shoot. Common values are 3200 (tungsten) and 5600 (daylight). 
Click and drag the slider from 1700 to 9400. Default is 5600.

Tint Adjusts the RGB color to compensate for yellow - green tinting of 
the scene at different color temperatures of the ambient light while 
you shoot. This is valuable when the ambient light source contains a 
significant amount of yellow or green, such as fluorescent. Click and 
drag the slider from -100 to 100. Default is 0.00.

ISO Allows the ISO level to change from 50 to 2000. Default is 320.
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FLUT™ The latest color science developed by RED. Allows you to balance 
your mid-grays in the center of the histogram without pushing 
highlight details over the edge.

Shadow Adjusts the overall black level of the image without affecting the 
white level. Click and drag the slider from 0.00 to 1.00. Default is 
0.00.

DRX Lets you recover potentially lost dynamic range by extending and 
balancing highlights, taking into account the rendering intent of the 
desired Kelvin and Tint white balance. Click and drag the slider from 
0.00 to 1.00. Default is 0.00.

Debayer Detail Choose from High (default), Medium, or Low.

Chroma Denoise Choose from Off (default), Minimum, Milder, Mild, Strong, or 
Maximum.

OLPF Controls the optical low-pass filter. Choose from Off (default), Low, 
Medium, or High.

Exposure Allows adjustment to the clip exposure. Click and drag the slider 
from -7.00 to 7.00. Default is 0.00.

Brightness Adjusts the overall brightness of the image. Lifts blacks without 
affecting the white level. Click and drag the slider from -10.00 to 
10.00. Default is 0.00.

Contrast Adjusts the tonal range of the image, which usually improves 
sharpness and detail. When you increase the Contrast, it increases 
tonal separation between adjacent gray levels but decreases the total 
number of discreet gray levels in the image.
Click and drag the slider from -1.00 to 1.00. Default is 0.00.

Saturation Affects the intensity of the red, green and blue channels. As the value 
increases color saturation increases. As the value decreases, so does 
the color decrease. If the value is set to high, colors might clip. If the 
level is set to 0.00, a monochromatic image with only gray tones 
appear. 
Click and drag the slider from 0.00 to 4.00. Default is 1.00

Red Increases or decreases the camera’s sensitivity to red light by 
amplifying the R channel digital video signal received from the 
sensor. A 0 (zero) no Red is visible, the image has a strong cyan cast. 
Click and drag the slider from 0.00 to 10.00. Default is 1.00.

Option Description
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5. Click Apply.

The changes apply to your clip. You can continue to make additional changes. 

If the clip is in the Source viewer, the changes are reflected in the Source viewer and in the 
Client monitor (if you have one attached).

If you click Cancel after you click Apply, the Set Source Settings window closes with the 
changes you made.

6. Click OK to save your change and close the window.

The system updates the bin column metadata with the new parameters.

n If you make changes in the Source Settings window and then relink the clip through AMA again, 
you still keep all the parameters that you set. 

Using RED Source Settings

Source Settings lets you choose from a selection of preset templates or you can create your own 
look. Each source setting has its own color values associated with it. There are a few different 
ways to obtain source settings:

• Camera and default source settings are included with the RED AMA plugin

• Link a RED clip from RED Alert! (imports the RSX source setting)

• Load a source setting onto your system (for example, an RLX, RSX, or RMD)

• Create a custom source setting

You cannot change the default RSX and RLX source settings, these are predefined. Once you 
make a change to a parameter, the setting becomes a Custom setting. At this time, you can only 
have one Custom setting.

Green Increases or decreases the camera’s sensitivity to green light by 
amplifying the G channel digital video signal received from the 
sensor. At 0 (zero), no green is visible, the image has a strong 
magenta cast. Click and drag the slider from 0.00 to 10.00. Default is 
1.00.

Blue Increases or decreases the camera’s sensitivity to blue light by 
amplifying the B channel digital video signal received from the 
sensor. At 0 (zero), no blue light is visible, the image has a strong 
yellow cast. Click and drag the slider from 0.00 to 10.00. Default is 
1.00.

Option Description
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You can load multiple RSX and RLX source settings. As you link a RED clip from RED Alert! 
(RSX) or load an RLX file, the setting appears in the Source Settings menu. 

Source Settings are helpful when you want to apply one setting to multiple clips in your bin. 

Different subclips from the same master clip can have different source settings.

When you edit a clip into a sequence, the material you edit in uses the clip’s current attribute 
values or RED source settings. If you change the RED source settings at a later point in your 
workflow, the sequence does not automatically adjust for the change. If you want the sequence to 
use the RED source settings for clips that you have changed since you edited, you must refresh 
the sequence. For procedures on how to refresh your sequence, see “Refreshing Sequences to 
Use Current Clip Attributes” on page 731.

Applying a RED Source Setting

To apply a source setting to a RED clip:

1. Right-click a RED clip in the bin (or Shift-click multiple clips), then choose Set Source 
Settings.

The Set Source Settings window opens and your clip displays in the viewer.

2. Select a setting (template) from the Source Settings menu. 

Source Settings vary depending on the files or templates loaded on your system.

3. Click Apply. 

The settings apply to the clip and if the clip is loaded in the Timeline, the video updates and 
displays in a Client monitor (if one is attached) and the Source monitor.

4. Click OK to save your settings and close the window.

The system updates the bin column RED metadata with the parameters.

Setting Origin

Camera Metadata Settings Default

Default Settings Default

Grade (RSX) Settings RED Alert!

filename RLX Setting RED Alert!

Grade (RMD) Setting REDCINE-X

Custom User created in Avid
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If you make additional changes after you select a setting, the system creates a Custom 
setting and Custom appears in the Settings list. You cannot make changes to a system 
generated setting, however you can use a system setting and make changes to create your 
own Custom setting.

To import additional source settings:

1. From the Source Settings window, click the Load button.

The Load External Settings window opens.

2. Browse to the Settings file.

3. Change the filter to display RSX, RLX or RMD files.

4. Select your setting and click OK.

The new source setting appears in the Source Settings menu, and is immediately applied to 
the clip.

Using the QuickTime AMA Plug-In

There are a few guidelines you should follow when you link QuickTime files through AMA. 

To link QuickTime media through the AMA method, you first need to create a QuickTime movie 
from a third-party application or through the Avid editing system. The third-party applications 
that supports creating a QuickTime movie include Adobe AfterEffects® and Final Cut Pro. This 
is done through the QuickTime Export dialog box which uses the Avid QuickTime Codecs. 
These codecs automatically install on your Avid editing system. At this time, Avid supports the 
Same as Source and Custom export settings options when you export with the Avid QuickTime 
codecs. This process creates an Avid compressed QuickTime media file, with a .mov extension. 
AMA only detects and links to Avid compressed QuickTime media.

n For information about exporting a QuickTime movie, see “Exporting QuickTime Movies” on 
page 1164.

QuickTime files use the .mov file name extension. After you link a QuickTime file through 
AMA, the file drops the .mov file name extension. QuickTime media is linked at the data rate at 
which it was recorded. 

A QuickTime AMA workflow is as follows:

1. Create a QuickTime movie with a supported codec in an application such as Adobe 
AfterEffects or Apple’s Final Cut Pro. 

Avid supports the Same as Source and Custom export settings options when you export with 
Avid QuickTime codec.

n See Adobe and Apple documentation for information on how to create a QuickTime movie.
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2. Move the created .mov file onto your Avid editing system.

3. Open a bin.

If there is no active bin, a dialog box appears asking you to select a bin.

4. Select File > AMA Link.

You can also right-click a bin and select AMA Link.

n To link to multiple QuickTime files, use the File > Link to AMA Volume(s) option and select the 
folder that stores all the QuickTime files.

n For information about AMA, see “The Avid Media Access (AMA) Workflow” on page 64.

The Open dialog box opens.

5. From the AMA Plugin Filter menu, select QuickTime.

6. Locate and select the .mov file(s) you want to link. Ctrl+click or Shift+click to select 
multiple files.

7. Click Open.

The clips appear in the active bin. A link icon appears next to the clips. 

If any of the movies you linked to were QuickTime with Alpha channel files, they appear in 
your bin as a Matte Key effect. The Alpha Channel options in the Import Settings Image tab 
apply to the QuickTime AMA linked file. Therefore, the QuickTime file will appear in the 
bin as a master clip if the Ignore option is set or will appear inverted or not inverted 
depending on the selected options. 

8. Use the linked clips to edit your sequence.

9. If you need to change the QuickTime clip in After Effects or FCP, open the existing file in 
After Effects or FCP and make the change.

If you change the number of tracks, change the duration of the clip or change the clips file 
name, when you relink through AMA, the system creates a new clip and will not overwrite 
or replace the existing clip in the bin.

If you change the number of tracks, the duration, or edit rate, but not the file name, any clips 
linked to the sequence will unlink and the clips display Media Offline.

n If you change the file name or the location of the clip, you can Relink to AMA files. For more 
information, see “Relinking to AMA-Linked QuickTime Files” on page 81.

10. From your Avid editing application, select Clear Monitor from the Clip Name menu above 
the monitors.

This clears the monitors and Timeline of any old clips.
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11. Render or export the newly changed QuickTime movie out of AfterEffects or FCP to the 
same folder location as the original file. Accept all overwrite prompts. Once the changed 
QuickTime movie is exported or rendered, refocus or open (if FCP or AfterEffects are on the 
same system) your Avid editing application.

The updated clip appears in your bin (and sequence) and replaces the old clip. If the clip is in 
the Source or Record monitor, it also will update.

12. Continue to edit your sequence or consolidate or transcode your sequence or clip.

n When you consolidate, if you want to keep your AMA clips linked to the original source, select 
the option “Keep Master clips linked to media on the original drive,” in the Copying Media Files 
dialog box. 

n  For information on consolidating your sequence, see “Consolidating Media” on page 567. For 
information on transcoding your sequence, see “Using the Transcode Command” on page 573.

Adjusting QuickTime Source Settings

You can change the dynamic range of a linked AMA QuickTime movie from 601/709 video 
range (16-235) to RGB range (0-255) or from RGB range (0-255) to 601/709 video range 
(16-235). This setting is only supported with QuickTime movies that were created with a 
non-Avid codec, including ProRes, H.264 and Animation.

When a QuickTime clip displays in the bin, the system displays the metadata columns of the 
clip’s color values. 

To change the QuickTime source settings:

1. Link the QuickTime clip through the File > Link to AMA File option or to link to multiple 
QuickTime files, use the File > Link to AMA Volume(s) option.

2. Right-click the QuickTime clip in the bin and select Set Source Settings.

n If your QuickTime movie was created with an Avid codec, the Set Source Settings option will not 
be available.

The Source Settings dialog box opens. The clip displays in the video area.
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3. Drag the video slider to the frame you want to view.

The new frame displays and the histogram updates.

The histogram is a tool that helps you more precisely adjust Source Settings. For more 
information about the histogram, see “Understanding the QuickTime Source Settings 
Histogram” in the Avid editing Help.

4. Set the appropriate options:

Option Description

Settings Default
Custom: User created in Avid.

Field Ordering Default
Progressive: The image is interpreted as a progressive image.
Interlaced - Odd (upper field first) ordered: Adjusts the clip so that 
the top field is played before the lower field.
Interlaced - Even (lower field first): Adjusts the clip so that the lower 
field is played before the top field.

Field Layout
(Available when Field 
Ordering > Interlaced 
is selected)

Merged (default): Alternates field information.
Split: Based on the field ordering selection (Interlaced Odd or 
Interlaced Even), fields will be split into one over the other. For 
example, all odd fields are over all even fields.
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5. Click Apply.

The changes apply to your clip. You can continue to make additional changes. 

If the clip is in the Source viewer, the changes are reflected in the Source viewer and in the 
Client monitor (if you have one attached).

If you click Cancel after you click Apply, the Set Source Settings window closes with the 
changes you made.

6. Click OK to save your change and close the window.

The system updates the bin column metadata with the new parameters.

n If you make changes in the Source Settings window and then relink the clip through AMA again, 
you still keep all the parameters that you set. 

Applying a QuickTime Source Setting

Source Settings lets you choose from a Custom of Default setting. Each source setting has its 
own color values associated with it. 

To apply a source setting to a QuickTime clip:

1. Right-click a QuickTime clip in the bin (or Shift-click multiple clips), then choose Set 
Source Settings.

The Set Source Settings window opens and your clip displays in the viewer.

2. Select a setting from the Source Settings menu. 

3. Click Apply. 

GFX/Video Level Do not modify levels: Leave as is
Expand video levels to graphic levels: Changes the dynamic range 
from an 601/709 video range (16-235) to RGB range (0-255).
Compress graphic levels to video levels: Changes the dynamic range 
from RGB (0-255) range to an 601/709 video range (16-235). This 
option is useful if you created a QuickTime movie with graphic 
levels in AfterEffects and then brought the clip into an Avid editing 
application. 

Option Description

Setting Origin

Default Settings Default

Custom User created in Avid
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The settings apply to the clip and if the clip is loaded in the Timeline, the video updates and 
displays in a Client monitor (if one is attached) and the Source monitor.

4. Click OK to save your settings and close the window.

The system updates the bin column metadata with the parameters.

If you make additional changes after you select a setting, the system creates a Custom 
setting and Custom appears in the Settings list. You cannot make changes to a system 
generated setting, however you can use a system setting and make changes to create your 
own Custom setting.

n The Load button does not apply to QuickTime media.

Understanding the QuickTime Source Settings Histogram

The histogram in the Source Settings window helps you visualize the distribution of color values 
in an image. You can use the histogram to adjust the Source Settings of your AMA media more 
precisely while avoiding clipping and color imbalance.

Example of a Source Settings histogram. The histogram plots color values on the horizontal axis and the 
percentage or proportional number of pixels on the vertical axis. The vertical lines represent the black point (left) 
and the white point (right), so the area between them is the safe color range.

The histogram plots color values that can be represented by the image bit-depth on the horizontal 
axis. Therefore, the width of the histogram is the same as the width of the image. The histogram 
plots the percentage, or proportional number of pixels in the image, with each particular color 
value on the vertical axis. The vertical axis is scaled according to the height of the maximum 
value in the plot. Whenever the histogram changes, the vertical axis rescales according to the 
new maximum.
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n Pixels with color values that are out of range are grouped into either the maximum or minimum 
color values on the plot. Spikes in either the highest or lowest color values might indicate loss of 
color information due to clipping.

Using the MXF AMA Plug-In

Material Exchange Format (MXF) is a wrapper or container format which encapsulates media 
and rich production metadata into a single file, which is useful for media storage and exchange. 
It is an open technology that can is implemented by different manufacturers.

MXF is designed to be flexible enough for use in all stages of content creation, from acquisition, 
to authoring, to distribution. The primary benefit of MXF is that it provides greater workflow 
efficiency by preserving useful metadata as media files make their way through the content 
creation process. The MXF format is independent of the type of content that it contains, so an 
MXF file can contain video and/or audio at any resolution or compression. In many instances 
MXF files encapsulate media which is already formatted to one of the existing industry 
standards.

You can select the MXF format when you capture, link, create titles, or render effects. See 
“Media Creation Settings” on page 125.

The MXF AMA plug-in is automatically installed when you install your editing application.

A typical workflow is as follows:

1. Create a supported MXF file (create a supported MXF file from your third party application, 
for example: Rhozet or Omneon). 

2. Move the .mxf file onto your Avid editing system.

3. Select File > AMA Link.

You can also right-click a bin and select AMA Link.

The Open dialog box opens.

4. From the AMA Plugin Filter menu, select MXF.

5. Select the file(s) you want to link. Ctrl+click or Shift+click to select multiple files.

6. Click Open.

The MXF clips appear in the active bin. A link icon appears next to the clips.

If the system cannot link a file, an error message displays informing you to open the Console 
window for more information about the file(s) in error.

If you move the clip from the original drive to another drive on your system, the clip displays 
as offline in your bin.
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n If you move a source file from one location to another and then back to the original location, you 
might need to refresh the bin to redisplay the clip. Close and reopen the bin to refresh the bin.

7. Use the linked clips to edit your sequence.

8. (Option) Rename the clips to help organize your material.

9. Consolidate or transcode your sequence or clips.

The media consolidates to the destination you set in the Media Creation dialog box.

n When you consolidate, if you want to keep your AMA clips linked to the original source, select 
the option “Keep Master clips linked to media on the original drive,” in the Copying Media Files 
dialog box. 

Workflow for Editing Clips with Ancillary Data and AMA

The following steps describe a typical workflow for editing XDCAM or MXF clips with 
ancillary data and AMA.

n Do not mix AMA and traditional workflows. Either use AMA or use the traditional import/batch 
import workflow.

You should be aware of the following: 

• You can link to the ancillary data clip without an Avid input/output hardware, however, in 
order to view the ancillary data in a monitor, an Avid Nitris DX or Avid Mojo DX device is 
required.

• If you consolidate the XDCAM or MXF clip or the sequence that contains the XDCAM or 
MXF clip with ancillary data, the ancillary data track stays with the consolidated clip or 
sequence. In addition, the Ancillary Data bin column populates with the DID and SDID 
numbers once you consolidate or transcode the clip with the ancillary data.

A typical workflow is as follows:

1. The Sony XDCAM or MXF AMA plug-in should be installed on your system.

2. For XDCAM, install the appropriate Sony XDCAM drivers.

3. For an XDCAM clip with ancillary data, insert the XDCAM disk.

The system links the XDCAM clip with ancillary data into a bin. The media itself remains 
on the disk. The clips point directly to the media on the disk. 

n Ancillary data is only supported with high resolution XDCAM clips. A proxy clip does not 
contain a data track, however once you relink to the high resolution XDCAM clip, the data track 
comes online.

n If you use multiple cards and you remove one of the cards, your media displays offline.
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4. For an MXF clip with ancillary data, select File > Link to AMA File(s).

The Select file(s) for AMA linking dialog box opens.

5. From the AMA Plugin Filter menu, select MXF.

6. Select the file(s) you want to link. Ctrl+click or Shift+click to select multiple files.

The MXF clip appears in the bin along with a new Ancillary Data bin column. 

n For information about AMA, see “The Avid Media Access (AMA) Workflow” on page 64.

7. Use the master clips to edit the sequence.

When you load the clip into a sequence, a Data track appears which contains the ancillary 
data.

8. You can then transcode or consolidate your sequence or clips.

n When you consolidate, if you want to keep your AMA clips linked to the original source, select 
the option “Keep Master clips linked to media on the original drive,” in the Copying Media Files 
dialog box.

When you consolidate the XDCAM or MXF clip or the sequence that contains the XDCAM 
or MXF clip with ancillary data, the ancillary data track stays with the consolidated clip or 
sequence.

n  For information on consolidating your sequence, see “Consolidating Media” on page 567. For 
information on transcoding your sequence, see “Using the Transcode Command” on page 573.

Understanding the Source Settings Histogram
The histogram in the Source Settings window helps you visualize the distribution of color values 
in an image. You can use the histogram to adjust the Source Settings of your AMA media more 
precisely while avoiding clipping and color imbalance.
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Example of a Source Settings histogram. The histogram plots color values on the horizontal axis and the 
percentage or proportional number of pixels on the vertical axis. The vertical lines represent the black point (left) 
and the white point (right), so the area between them is the safe color range.

The histogram plots color values that can be represented by the image bit-depth on the horizontal 
axis. Therefore, the width of the histogram is the same as the width of the image. The histogram 
plots the percentage, or proportional number of pixels in the image, with each particular color 
value on the vertical axis. The vertical axis is scaled according to the height of the maximum 
value in the plot. Whenever the histogram changes, the vertical axis rescales according to the 
new maximum.

n Pixels with color values that are out of range are grouped into either the maximum or minimum 
color values on the plot. Spikes in either the highest or lowest color values might indicate loss of 
color information due to clipping.

Your Avid editing application draws separate histograms for the red, green, and blue color 
components. The histograms for each color stack on top of one another, with the fill color 
changing appropriately to indicate overlap. The following illustration shows the colors produced 
by overlap.
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Adjusting the Source Settings Histogram

You can adjust the Source Settings Histogram in two ways. You can toggle drawing a histogram 
for an individual color, and you can zoom the vertical axis.

To adjust the Source Settings Histogram:

t Right-click anywhere inside the histogram graph, and then select one of the following 
options.

Option Result

Red
Green
Blue

Enables or disables the histogram display for the selected color. A check mark 
indicates that the histogram for that particular color displays.

Zoom In Zooms in on the lower half of the vertical axis.

Changes the scaling of the vertical axis so that the height is half that of the 
maximum value in the plot. You can zoom in indefinitely to display, for example, 
1/4, 1/8, or 1/16 of the maximum value.

Zoom Out Zooms out of the vertical axis by a factor of two.

Changes the scaling of the vertical axis to be twice that of the maximum value in 
the plot. You can zoom out indefinitely to display, for example, 4, 8, or 16 times 
the height of the maximum value.
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Working with Export Volumes

The Avid editing application supports the creation of AS-02 Export Volumes. AS-02 is a 
specification for grouping multiple versions of program content into one single bundle. These 
bundles provide an efficient approach for working in a file-based environment.

For example, if you have a sequence with an English audio mix and a sequence with the same 
video but with a Spanish audio mix, creating an AS-02 Export Volume allows you to have all the 
program elements contained in a bundle without redundancy. The same video essence file can be 
the source for the both the English and the Spanish versions. This is useful if you want to save 
time on export and reduce used disk space.

The basic workflow is to create a new Export Volume Bin, copy the sequence or sequences you 
want to the Volume Bin, commit the assets in the Export Volume Bin, and then archive the AS-02 
bundle folder. You can also link to an existing AS-02 bundle. 

The bundle folder structure is shown below. This is for reference only. These elements will be 
automatically created for you when you commit an Export Volume Bin.

• The Asset.mxf file is the sequence (version).

• The Manifest.xml file lists the creator information, creation date, version information and a 
list of all the files and folders in the bundle.

• The Shim.xml file is used as a template or settings file that constrains the rules for a specific 
facility. 

Reset Zoom Resets the zoom so that the vertical axis boundary is equal to the maximum value 
in the plot.

Option Result
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• The Media folder contains all the media files included in the bundle.

• The Extra folder contains a copy of the unflattened sequence (AAF composition only). The 
Extra folder can also contain any other files you want to keep with the bundle, such as 
scripts, graphics, etc. 

Creating an Export Volume

You can create an export volume to place all program elements into a bundle.

To create a new export volume:

1. Select File > New Export Volume.

The Export Volume dialog box opens.

Asset

Asset.mxf

Manifest.xml

Shim.xml

Media

Extra
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2. Select a Volume Type, for example AS-02.

3. Click Set to select the path where you want the Export Volume to reside.

4. Enter a name for the volume.

5. Click Set to select the path to the shim template you want to use.

- AS-02 supports J2K, Uncompressed 10b RGB, DNxHD, AVCI, IMX and 
Uncompressed 8b for SD.

- All DNxHD templates are tuned to the DNxHD 220x family. That means depending on 
the project type, selecting a DNxHD template will export to a DNxHD 10b codec.

- AS-02 Shim templates for all supported resolutions are located in the Supporting Files 
folder.

- You can choose any one of these templates depending on the desired output 
codec/format.

- You can also create a folder named Default at the root of the AS-02 Templates folder 
where you can place custom templates. For example, you can duplicate the 
AS-02_Shim_DNxHD_1080i_59.94.xml found in the DNxHD folder, modify it (to a 
different audio sample rate or DNxHD resolution) and place the duplicate in the Default 
folder. This duplicated template will now be the default template for 1080i59 projects. 

- DNxHD resolutions are supported except DNxHD 100 and DNxHD 36.

6. Click OK.

The Export Volume bin opens.
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Left to right: Export Volume Type, Path to Asset folder, Properties button, Commit button

Moving Assets to an Export Volume

You can move the desired assets to the Export Volume.

To move assets to the Export Volume:

1. Open the bin that contains the sequence or sequences you want to write to the Export 
Volume. 

2. Select and drag the sequence(s) to the Export Volume.

A copy of the sequence(s) appears in the Export Volume. 
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n You can only drag sequences to an AS-02 Export Volume Bin. If you try to drag master clips, 
effects, titles, etc, you will receive a message indicating that some assets that you selected could 
not be dragged to the Volume Bin. If you receive this message, open the Console Tool to see the 
list of items that were not written.

Committing Assets to an Export Volume

Once you commit the assets, the sequence is flattened to the OP1b format, the video is encoded 
to the J2K codec and audio saved as PCM. 

To commit the assets to the Export Volume:

1. Open the Export Volume that contains the sequence(s) to commit.

2. Click the Commit button to commit the assets to the AS-02 bundle.

The sequence along with its associated media files populate the Export Volume. 

Note the Media Status column indicates the committed status of each asset in the volume. 
Green indicates the asset is committed. Yellow indicates the asset is not committed. Red 
indicates the asset is offline.
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Once the assets are committed, the following are written to the bundle folder:

- The sequence (version)

- The essence files

- The manifest (a file listing the creation date, creator, version information and a list of all 
the files and folders in the bundle.)

- The shim file (used as a template or settings file that constrains the rules for the specific 
facility)

- An AAF copy of the unflattened sequences(s) in the Extras folder

Archiving the AS-02 Bundle

Once you have committed the assets to the Export Volume, you can archive the AS-02 bundle.

To archive the Assets Folder.

1. Locate the AS-02 bundle folder by accessing the path you set in step 4 of Creating an Export 
Volume.

2. Copy the AS-02 bundle folder to your archive server.

Linking to an existing AS-02 Bundle

You can open an existing AS-02 bundle.
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To link to an existing AS-02 Volume:

1. Select File > Link to Volume for Export.

2. Select the folder where the AS-02 bundle resides.

3. Click OK.

4. A new volume bin opens with the AS-02 assets.

You can also choose to Link to AMA Volume if you want to open the assets as Read-only in 
a classic bin.

AS-11 Support

The Avid editing application supports the Advanced Media Workflow Association (AMWA) 
AS-11 specification. This specification is used in broadcast environments. The specification 
defines a set of rules that constrain the specification. AS-11 is an OP1A MXF file format for the 
delivery of finished programming. This specification requires program segment markers. 
Program segmentation defines specific regions of a show, for example a segment marker for the 
A-block, B-block and C-block. See “Adding Spanned Markers While Editing” on page 651 to 
apply these markers before you export your sequence.

To export a sequence as AS-11:

1. Select the sequence you want to export as AS-11.

2. Click File > AMA File Export, or right click the sequence and select AMA File Export.

The AMA File Export dialog opens.
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3. Select File Type AS-11.

4. (Option) Select the Use Marks or Use Enabled Tracks option.

t When you select Use Marks, your Avid editing application uses current IN and OUT 
points in the selected clip or sequence to determine starting and ending frames for the 
export. To export the entire clip or sequence, deselect this option or mark the entire clip 
or sequence.

t When you select Use Enabled Tracks, your Avid editing application exports the tracks 
that are enabled in the Timeline. To export all the tracks in the sequence, deselect this 
option.

5. Click the Directory Set button to and browse to the location where you want the AS-11 file 
saved.

6. Click Select Folder.

7. Select the Shim Set button to locate the Shim file you want associated with the export and 
click Open. Avid provides shims in the following location: 

- (Windows) Program Files/Avid/EditingApplicationName/SupportingFiles

- (Macintosh) MacintoshHD/Applications/EditingApplicationName/SupportingFiles

The Descriptive Metadata populates in the window depending upon the shim you selected.

8. Enter the specific program information in the Descriptive Metatdata fields.
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This is the descriptive data stored in the AS-11 export that describes Essence data. For 
example, the language, series title, program title, episode title, etc.

9. Click Save. 

The AS-11 file is exported to the selected directory.

When you perform an AMA link to the AS-11 sequence, the spanned markers are 
represented in the source Timeline and all the descriptive metadata appears in the Bin 
columns.
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